Contents

EC-C110 User's Guide................................................................. 11
Product Basics .................................................................................. 12
Using the Control Panel ............................................................... 12
  Control Panel Buttons............................................................. 13
  The LCD Screen......................................................................... 13
Status Icons.................................................................................... 14
Entering Characters on the LCD Screen ....................................... 15
Changing LCD Screen Language.................................................... 16
  Turning On Quiet Mode........................................................... 16
Printer Parts Locations.................................................................... 17
  Printer Parts - Top................................................................. 18
  Printer Parts - Inside and Bottom............................................ 19
Battery Charging............................................................................. 20
  Charging the Built-in Battery Using the AC Adapter............... 20
  Charging the Built-in Battery Using the USB Cable.............. 21
Using the Optional Battery......................................................... 22
  Installing the Optional Battery............................................... 22
  Removing the Optional Battery.............................................. 25
  Charging the Optional Battery............................................. 27
  Battery Safety Instructions................................................... 29
The Power Off and Sleep Timers.................................................. 30
  Changing the Sleep Timer Setting......................................... 30
  Changing the Power Off Timer Setting............................... 31
Epson Connect Solutions for Smartphones, Tablets, and More.................................................. 33
  Setting Up Epson Connect Services.................................... 33
  Using Epson Email Print....................................................... 34
  Using the Epson iPrint Mobile App....................................... 35
  Using Epson Remote Print................................................... 35
Using AirPrint................................................................................. 36
Android Printing Using the Epson Print Enabler......................... 37
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Mopria Print Service</td>
<td>37</td>
</tr>
<tr>
<td>Using Fire OS Printing</td>
<td>38</td>
</tr>
<tr>
<td>Using Windows 10 Mobile Printing</td>
<td>38</td>
</tr>
<tr>
<td>Using Epson Print and Scan App with Windows Tablets</td>
<td>39</td>
</tr>
<tr>
<td>Voice-activated Printing</td>
<td>39</td>
</tr>
<tr>
<td><strong>Wi-Fi Networking</strong></td>
<td>41</td>
</tr>
<tr>
<td>Network Security Recommendations</td>
<td>41</td>
</tr>
<tr>
<td>Wi-Fi Infrastructure Mode Setup</td>
<td>42</td>
</tr>
<tr>
<td>Selecting Wireless Network Settings from the Control Panel</td>
<td>43</td>
</tr>
<tr>
<td>Wi-Fi Direct Mode Setup</td>
<td>45</td>
</tr>
<tr>
<td>Connecting to a Mobile Device</td>
<td>46</td>
</tr>
<tr>
<td>Enabling Wi-Fi Direct Mode (Simple AP)</td>
<td>47</td>
</tr>
<tr>
<td>Modifying the Wi-Fi Direct Network Name or Password</td>
<td>48</td>
</tr>
<tr>
<td>Wi-Fi Protected Setup (WPS)</td>
<td>49</td>
</tr>
<tr>
<td>Using WPS to Connect to a Network</td>
<td>49</td>
</tr>
<tr>
<td>Printing a Network Status Sheet</td>
<td>50</td>
</tr>
<tr>
<td>Printing a Network Connection Report</td>
<td>51</td>
</tr>
<tr>
<td>Network Connection Report Codes and Messages</td>
<td>52</td>
</tr>
<tr>
<td>Changing or Updating Network Connections</td>
<td>57</td>
</tr>
<tr>
<td>Accessing the Web Config Utility</td>
<td>57</td>
</tr>
<tr>
<td>Changing a USB Connection to a Wi-Fi Connection</td>
<td>58</td>
</tr>
<tr>
<td>Connecting to a New Wi-Fi Router</td>
<td>58</td>
</tr>
<tr>
<td>Disabling Wi-Fi Features</td>
<td>59</td>
</tr>
<tr>
<td><strong>Loading Paper</strong></td>
<td>60</td>
</tr>
<tr>
<td>Loading Paper and Envelopes</td>
<td>60</td>
</tr>
<tr>
<td>Selecting the Paper Source Settings - Control Panel</td>
<td>63</td>
</tr>
<tr>
<td>Paper or Media Type Settings - Control Panel</td>
<td>65</td>
</tr>
<tr>
<td>Turning Off the Paper Setting Alert</td>
<td>65</td>
</tr>
<tr>
<td>Paper Loading Capacity</td>
<td>66</td>
</tr>
<tr>
<td>Compatible Epson Papers</td>
<td>67</td>
</tr>
<tr>
<td>Borderless Paper Type Compatibility</td>
<td>68</td>
</tr>
<tr>
<td>Paper or Media Type Settings - Printing Software</td>
<td>69</td>
</tr>
</tbody>
</table>

4
Printing from a Computer ................................................................................................................................................. 70
  Printing with the Standard Epson Printer Software - Windows .......................................................................................... 70
    Selecting Basic Print Settings - Windows ......................................................................................................................... 71
      Print Quality Options - Windows ............................................................................................................................... 73
    Multi-Page Printing Options - Windows ......................................................................................................................... 73
  Selecting Double-sided Printing Settings - Windows ........................................................................................................ 74
    Double-sided Printing Options - Windows ....................................................................................................................... 75
  Selecting Additional Layout and Print Options - Windows .................................................................................................. 76
    Custom Color Correction Options - Windows ................................................................................................................ 78
    Image Options and Additional Settings - Windows ......................................................................................................... 79
  Header/Footer Settings - Windows .................................................................................................................................. 80
  Selecting a Printing Preset - Windows .............................................................................................................................. 81
  Selecting Extended Settings - Windows ............................................................................................................................ 83
    Extended Settings - Windows ......................................................................................................................................... 84
  Printing Your Document or Photo - Windows.................................................................................................................... 85
  Selecting Default Print Settings - Windows ....................................................................................................................... 86
    Changing the Language of the Printer Software Screens .................................................................................................. 87
    Changing Automatic Update Options .................................................................................................................................. 88
  Printing with the Built-in Basic Driver - Windows ............................................................................................................... 89
    Installing the Basic Driver Software - Windows ................................................................................................................ 90
    Selecting Print Settings - Windows Basic Driver ........................................................................................................... 90
    Adjusting Print Density ................................................................................................................................................. 94
    Adjusting Color .......................................................................................................................................................... 95
  Printing with the Built-in Epson Driver - Windows 10 S ........................................................................................................ 96
    Selecting Print Settings - Windows 10 S .......................................................................................................................... 96
  Printing on a Mac ........................................................................................................................................................... 99
    Selecting Basic Print Settings - Mac ............................................................................................................................ 100
      Print Quality Options - Mac ........................................................................................................................................ 103
      Print Options - Mac .................................................................................................................................................. 103
    Selecting Page Setup Settings - Mac ................................................................................................................................ 104
    Selecting Print Layout Options - Mac ........................................................................................................................... 105
    Managing Color - Mac .................................................................................................................................................. 105
    Color Matching and Color Options - Mac ....................................................................................................................... 106
EC-C110 User's Guide

Welcome to the EC-C110 User's Guide.

For a printable PDF copy of this guide, click here.
Product Basics

See these sections to learn about the basic features of your product.

Using the Control Panel
Printer Parts Locations
Battery Charging
Using the Optional Battery
The Power Off and Sleep Timers
Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint
Android Printing Using the Epson Print Enabler
Using the Mopria Print Service
Using Fire OS Printing
Using Windows 10 Mobile Printing
Using Epson Print and Scan App with Windows Tablets
Voice-activated Printing

Using the Control Panel

See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons
The LCD Screen
Status Icons
Entering Characters on the LCD Screen
Changing LCD Screen Language
Turning On Quiet Mode

Parent topic: Product Basics
Control Panel Buttons

1. The I/Ø power button
2. The LCD screen
3. The arrow buttons and the OK button; navigate menus
4. The 🔄 cancel button; stops printing or returns to the previous screen

Parent topic: Using the Control Panel

The LCD Screen

1. Plain Paper Density Setting icon
2. Network status
3 Battery status
4 Ink and maintenance box status
5 **Color Adjustment** icon

**Parent topic:** Using the Control Panel

### Status Icons

Status icons may be displayed on the LCD screen depending on the product's status.

<table>
<thead>
<tr>
<th>Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Battery icon" /></td>
<td>The battery is fully charged.</td>
</tr>
<tr>
<td><img src="image" alt="Battery icon" /></td>
<td>The battery is running low.</td>
</tr>
<tr>
<td><img src="image" alt="Battery icon" /></td>
<td>The battery is too hot or too cold. Select <strong>Menu &gt; Battery</strong> to check the battery status.</td>
</tr>
<tr>
<td><img src="image" alt="Battery icon" /></td>
<td>The battery is charging.</td>
</tr>
<tr>
<td><img src="image" alt="Ink icon" /></td>
<td>Approximate ink levels.</td>
</tr>
<tr>
<td><img src="image" alt="Ink icon" /></td>
<td>Approximate service life remaining for the maintenance box.</td>
</tr>
<tr>
<td><img src="image" alt="Ink icon" /></td>
<td>Ink is low or the maintenance box is nearly full.</td>
</tr>
<tr>
<td><img src="image" alt="Ink icon" /></td>
<td>An ink cartridge is expended.</td>
</tr>
<tr>
<td><img src="image" alt="WiFi icon" /></td>
<td>A Wi-Fi network is not available, or the printer is connecting to a Wi-Fi network.</td>
</tr>
<tr>
<td><img src="image" alt="WiFi icon" /></td>
<td>A Wi-Fi network error has occurred or the product is searching for a connection.</td>
</tr>
<tr>
<td><img src="image" alt="WiFi icon" /></td>
<td>A Wi-Fi connection has been established. The number of bars indicates the connection's signal strength.</td>
</tr>
<tr>
<td><img src="image" alt="WiFi icon" /></td>
<td>A Wi-Fi Direct mode connection is not available, or the printer is connecting in Wi-Fi Direct mode.</td>
</tr>
<tr>
<td><img src="image" alt="WiFi icon" /></td>
<td>A Simple AP mode connection has been established.</td>
</tr>
<tr>
<td>Icons</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>0 +1</td>
<td>Print density has been increased.</td>
</tr>
<tr>
<td>🌈</td>
<td>The color has been adjusted.</td>
</tr>
</tbody>
</table>

Parent topic: Using the Control Panel

**Entering Characters on the LCD Screen**

Follow these guidelines to enter characters for passwords and other settings.

![Enter Password](image)

1  Moves the cursor left or right  
2  Switches between characters and numbers or symbols  
3  Enters a space  
4  Deletes the previous character  
5  Select when you are finished

Parent topic: Using the Control Panel
Changing LCD Screen Language

You can change the language used on the LCD screen.

1. From the home screen, select **Menu** and press the **OK** button.
   
   You see this screen:

   ![Menu Screen](image)

2. Press the arrow buttons to select **Printer Setup** and press the **OK** button.
3. Press the arrow buttons to select **Language** and press the **OK** button.
4. Select a language and press the **OK** button.

   *Parent topic: Using the Control Panel*

Turning On Quiet Mode

You can reduce the noise the product makes by turning on Quiet Mode.

**Note:** Turning on this setting may reduce print speed.

1. From the home screen, select **Menu** and press the **OK** button.
You see this screen:

You see this screen:

2. Press the arrow buttons to select Printer Setup and press the OK button.
3. Press the arrow buttons to select Quiet Mode and press the OK button.
4. Select On and press the OK button.

Parent topic: Using the Control Panel

Printer Parts Locations

See these sections to identify the parts on your printer.

Printer Parts - Top
Printer Parts - Inside and Bottom

Parent topic: Product Basics
Printer Parts - Top

1. Micro USB port
2. Power inlet
3. Rear paper feed
4. Edge guide
5. Printer cover
6. Control panel
7. Output slot
8. Power light
9. Battery charging light

Parent topic: Printer Parts Locations
Printer Parts - Inside and Bottom

1  Inner cover
2  Ink cartridge holder (do not remove)

1  Security lock slot (for an optional security cable)
2  Rear cover
3  Maintenance box cover
Battery Charging

You can charge the built-in battery by connecting the power cord and AC adapter, and plugging the product into an electrical outlet. Or, you can connect the product to your computer (or other USB power source) using the USB cable.

Battery status is indicated on the LCD screen.

Note the following:

• The battery is not a user-replaceable part.
• Even when the product is not in use, the battery runs down. Make sure you turn off the product when you are not using it and charge the battery on a regular basis.
• The battery runs down faster in low temperature environments.
• The battery may be hot right after it is charged or used; this is normal.
• Charge the battery within a range of 50 to 95 °F (10 to 35 °C). The battery may not charge fully or may deteriorate if the environment is too hot or cold.
• It takes about 2.5 hours to fully charge the battery.
• You do not need to use the battery completely before charging it.
• If the battery runs out quickly even after it is fully charged, it may be at the end of its service life. Contact Epson to replace the battery.
• If you do not use the printer for a long time, charge the battery on a regular basis to avoid letting it run out. If the printer does not turn on, charge the battery for more than thirty minutes, and then turn the printer on again.
• The \( \text{Battery Charging Light} \) is orange during charging and turns off when the battery is fully charged. The light flashes if the environment is too cold or too hot to charge the battery.

Charging the Built-in Battery Using the AC Adapter

Charging the Built-in Battery Using the USB Cable

Parent topic: Product Basics

Charging the Built-in Battery Using the AC Adapter

You can charge the built-in battery using the AC adapter.
1. Connect the power cord to the AC adapter and connect the AC adapter to the product.

2. Plug the other end of the power cord into an electrical outlet.

Parent topic: Battery Charging

Charging the Built-in Battery Using the USB Cable

You can charge the built-in battery by connecting the included micro USB cable to a computer or any compatible USB power source, including some automobiles.

For USB charging, the printer must be turned off or in sleep mode.

1. To charge from a computer, make sure the computer is on and not in sleep or hibernation mode.
2. Connect the micro USB cable to the printer's micro USB port and to any USB port on the computer.
Note: You cannot charge the battery using a USB hub; connect the product directly to the computer. If battery charging does not start, select Menu > Battery > Battery Settings > USB Power Supply via PC > On on the control panel and try again.

The battery charging light turns on.

During charging, the computer recognizes the printer as a USB mass storage device.

Parent topic: Battery Charging

Using the Optional Battery

See these sections for instructions on using your product with the optional battery.

You can purchase genuine Epson ink and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Use this part number to order an optional battery: C12C934941

Note: Epson recommends the use of a genuine Epson battery. Epson cannot guarantee the quality or reliability of non-genuine batteries. The use of a non-genuine battery may cause damage that is not covered by Epson’s warranties, and under certain circumstances, may cause erratic printer behavior.

Installing the Optional Battery
Removing the Optional Battery
Charging the Optional Battery
Battery Safety Instructions

Parent topic: Product Basics

Installing the Optional Battery

Make sure you have an optional battery before you begin.

1. Turn off the product using the power button.
2. Disconnect any connected cables.
3. Remove the rear cover as shown.
Caution: Do not touch the area shown or allow it to get wet. Do not allow paper clips or other metal objects to contact this area; otherwise the product may be damaged.

4. Place the product on its side and insert the battery as shown. Press the battery down until it clicks into place.

5. Turn the product on using the \((\mathord{\bigcirc})\) power button.
6. Check the status of the battery on the home screen.

![Battery Status Icons]

<table>
<thead>
<tr>
<th>Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Battery Full" /></td>
<td>The optional battery is fully charged.</td>
</tr>
<tr>
<td><img src="icon" alt="Battery Low" /></td>
<td>The optional battery is running low.</td>
</tr>
<tr>
<td><img src="icon" alt="Battery Hot/Cold" /></td>
<td>The optional battery is too hot or too cold. Select <strong>Menu &gt; Battery</strong> to check the battery status.</td>
</tr>
<tr>
<td><img src="icon" alt="Battery Charging" /></td>
<td>The optional battery is charging.</td>
</tr>
</tbody>
</table>

Parent topic: Using the Optional Battery

**Removing the Optional Battery**

1. Turn off the product using the I/0 power button.
2. Disconnect any connected cables.
3. Push the button on the side of the battery and pull the battery off.

4. Insert the rear cover as shown and push it in until it clicks into place.
Charging the Optional Battery

You can charge the optional battery using the AC adapter whether it is attached to the product or not. It takes approximately 2.5 hours for the battery to fully charge.

1. Connect the power cord to the AC adapter and connect the AC adapter to the product.
2. Plug the other end of the power cord into an electrical outlet.

Battery is attached to the product
Note: The icon appears on the LCD screen while the battery is charging.

Battery is not attached to the product

Note: The battery charging light turns on while the battery is charging.

Parent topic: Using the Optional Battery
Battery Safety Instructions

Follow these battery safety instructions when using the printer.

• If the battery is not fully charged within the specified time, stop charging. Otherwise, the battery could become hot, emit smoke, rupture, or catch fire.

• Do not place the product in a microwave oven or high-pressure container. Otherwise, the battery could become hot, emit smoke, rupture, or catch fire.

• If battery acid gets into your eyes or on your skin, immediately rinse the affected area thoroughly with water and seek medical treatment. Otherwise, permanent eye damage could result.

• If liquid leaks from the product (or the product has a bad odor), move the product away from flammable objects. Otherwise, electrolyte leaked from the battery will catch fire or cause smoke or flame.

• Do not drop or throw the product or subject it to strong shocks. Otherwise, the battery could leak or the protection circuit in the battery could be damaged.

• Do not leave the battery in a hot location such as near a fire or a heater. Otherwise, the plastic separator could melt and the individual cells could short-circuit and the battery could become hot, emit smoke, rupture, or catch fire.

• Do not charge the battery with devices other than the specified product. Otherwise, the performance and life of the battery could decrease or device damage can occur.

• Do not charge the battery near an open flame or in very hot locations. If the protection circuit in the battery is activated, you will not be able to charge the battery. If the protection circuit is damaged, the battery could become hot, emit smoke, rupture, or catch fire.

• Do not reverse the polarity of the external battery connections (terminals) and do not forcefully connect the battery to the charger or product even if the battery cannot be connected easily. Be sure to confirm the polarity of the battery when connecting it. If the battery is connected incorrectly during charging, the battery will be reverse-charged and an abnormal chemical reaction could occur or the battery could become hot, emit smoke, rupture, or catch fire.

• Do not use the product if it is leaking or damaged in any way.

• Do not leave the product in a vehicle. Otherwise, the battery could overheat.

• Do not handle the battery with wet hands or touch the battery terminals.

• Do not place, store, or charge the battery near water, heat sources, metal objects or in locations subject to shocks, vibrations, condensation, high temperature or humidity.

• Do not incinerate, heat, puncture, strike, step on, or insert an object into any openings in the battery.

• Do not disassemble, modify, or remove the outside case on the battery.
• If the battery overheats, or becomes discolored or deformed, remove the battery from the product and do not use it.
• Do not connect the battery to an electrical outlet or to a car cigarette lighter socket.
• Do not solder any item onto the battery.
• If the battery is swallowed, seek medical treatment immediately.
• Make sure to dispose of the battery in accordance with local laws. Before disposing of the battery, make sure it is completely discharged.
• Use only the battery model specified for use with the product.
• Use only the AC adapter model specified to charge the battery and operate the product.

Parent topic: Using the Optional Battery

The Power Off and Sleep Timers

The product enters sleep mode or turns off automatically if it is not used for a period of time. You can adjust the time period before power management begins, but increasing the time reduces the product's energy efficiency.

Changing the Sleep Timer Setting
Changing the Power Off Timer Setting

Parent topic: Product Basics

Changing the Sleep Timer Setting

In sleep mode, the LCD screen turns off. Press any button to turn it back on.

You can use the product's control panel to change the time period before the product enters sleep mode.

1. From the home screen, select Menu and press the OK button.
You see this screen:

2. Press the arrow buttons to select **Printer Setup** and press the **OK** button.
3. Press the arrow buttons to select **Sleep Timer** and press the **OK** button.
   You see this screen:

4. Select the desired time period before the product goes to sleep and press the **OK** button.

**Parent topic:** The Power Off and Sleep Timers

**Changing the Power Off Timer Setting**

You can use the product’s control panel to change the time period before the printer turns off automatically. You can set two different time periods: one for external power, and one for battery power.
1. From the home screen, select **Menu** and press the **OK** button. 
   You see this screen:

![Menu Screen]

2. Press the arrow buttons to select **Printer Setup** and press the **OK** button.
3. Press the arrow buttons to select **Power Off Timer** and press the **OK** button.
   You see this screen:

![Power Off Timer Screen]

4. Do one of the following:
   - To set the timer for when external power is in use, press the **OK** button.
   - To set the timer for when the product is running on the battery, press the arrow button to select **Battery Power** and press the **OK** button.
5. Select the length of time after which you want the product to automatically turn off when it is not in use. Then press the OK button.

Parent topic: The Power Off and Sleep Timers

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print documents, photos, emails, and web pages from your home, office, or even across the globe.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Setting Up Epson Connect Services
Using Epson Email Print
Using the Epson iPrint Mobile App
Using Epson Remote Print
Parent topic: Product Basics
Related tasks
Using AirPrint
Android Printing Using the Epson Print Enabler
Using Fire OS Printing
Using Windows 10 Mobile Printing

Setting Up Epson Connect Services

If you did not activate your product's email address for use with Epson Connect when you set up your product, you can activate it using the product control panel.

1. From the home screen, select Menu and press the OK button.
You see this screen:

2. Press the arrow buttons to select **Epson Connect Services** and press the **OK** button.
3. Select **Register/Delete**.
4. Follow the instructions on the screen to activate your product's email address.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi Networking

---

### Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone, tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the attachments will print automatically.

1. Connect your product to your network. See the link below.
2. If you did not already set up Email Print when you installed your product software, see the link below to use your product control panel to activate your unique email address. Or visit epson.com/connect (U.S), epson.ca/connect (Canada), or epsonconnect.com (Caribbean) to learn more about Email Print, create your Epson Connect account, and register your product to the Epson Connect service.
3. Now you are ready to send and print emails to your product's Email Print address.

**Note:** Go to epsonconnect.com and log into your Epson Connect account to personalize your product's email, adjust print settings, and set up other Epson Connect services.
Using the Epson iPrint Mobile App

Use this free Apple and Android app to print with networked Epson products. Epson iPrint lets you print PDFs, Microsoft Office documents, photos, and web pages from your device or from popular cloud services such as Box, Dropbox, Evernote, Google Drive, or Microsoft OneDrive.

1. Connect your product to your wireless network. See the link below.
2. Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to learn more about Epson iPrint and check the compatibility of your mobile device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.

Now you are ready to print with your mobile device and your Epson product.

Using Epson Remote Print

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson Email-enabled product anywhere in the world.

1. Connect your Epson product to your wireless network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software, visit epsonconnect.com to create your account and register your product to the Epson Connect service.

   Note: Make a note of your product's email address.

3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print Driver software.
4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.
6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer application and choose the Remote Print option for your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

- Wi-Fi Networking

---

**Using AirPrint**

AirPrint enables instant wireless printing from iPhone, iPad, iPod touch, and Mac without the need to install drivers or download software.

![Works with Apple AirPrint](image)

**Note:** If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to enable the messages, if necessary.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

**Note:** For details, see the AirPrint page on the Apple website.

**Parent topic:** Product Basics

**Related references**

- Paper or Media Type Settings - Printing Software

**Related tasks**

- Selecting the Paper Source Settings - Control Panel
Android Printing Using the Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson product and print.

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Epson Print Enabler plug-in from Google Play.
3. Go to Settings on your Android device, select Printing, and enable the Epson plug-in, if necessary.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu icon and print whatever is on the screen.

Note: If you do not see your product, tap All Printers and select your product.

Using the Mopria Print Service

You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to your Epson product or any Mopria-certified product from other manufacturers. You can download the Mopria Print Service from Google Play.

Note: For details on the Mopria Print Service, click here (U.S) or click here (Canada).

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Mopria Print Service app from Google Play.

Note: On some Samsung Galaxy devices, Mopria may come preinstalled.

3. Go to Settings on your Android device, select Printing, and enable the Mopria Print Service, if necessary.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu icon and select Print. Then select All printers, select your Epson product, adjust your print settings, and print.

Parent topic: Product Basics

Related topics
Wi-Fi Networking

Using Fire OS Printing

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. With just a few taps in Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.
3. Now you are ready to print. From your Amazon application, tap the print option and select your product to print whatever is on the screen.

Note: If you see a message telling you that a plug-in is required, tap OK and tap Download. If your Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria Print Service app to print.

Parent topic: Product Basics
Related topics
Wi-Fi Networking

Using Windows 10 Mobile Printing

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. Look for the print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.
3. Now you are ready to print. From your Windows 10 application, tap the print option and select your product to print whatever is on the screen.
Using Epson Print and Scan App with Windows Tablets

You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface RT or Pro tablet with networked Epson products. The Epson Print and Scan app allows you to scan and capture images right to your tablet or to Microsoft OneDrive.

**Note:** The Epson Print and Scan app does not support Windows 10 Mobile printing and does not supply scanning functions for products without scanners.

1. Connect your Epson product to your wireless network. See the link below.
2. Download the Epson Print and Scan app from the Microsoft Windows Store.
3. Connect your Windows tablet to the same wireless network as your product.
4. Open the Epson Print and Scan app and select your Epson product.

Now you are ready to print photos or scan.

Voice-activated Printing

Take advantage of voice-activated, hands-free printing from your Epson product with Alexa, Siri, and Google Assistant. Depending on which voice assistant you use, you can ask your product to print photos, calendars, recipes, photo props, and more. Click here for more information.

1. Connect your product to your network. See the link below.
2. Do one of the following:
   - Alexa or Google Assistant: Set up your product's email address for use with Epson Connect. See the link below to activate it from the product control panel.
   - Siri: Download and install the Epson iPrint app then select your product. See the link below for instructions.
3. Click here for instructions on how to set up your product and voice assistant to use the voice-activated printing feature.

Now you are ready to print with your voice and your Epson product.
Related topics
Wi-Fi Networking
Wi-Fi Networking

See these sections to use your product on a Wi-Fi network.

Network Security Recommendations
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Printing a Network Connection Report
Changing or Updating Network Connections

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and fax lines, and other intrusions:

• **Enable security on your wireless LAN**
  Enable the appropriate security on the wireless LAN you plan to use with your product. Network security such as a network password can deter interception of traffic over the wireless LAN. Your router may already have a default password enabled by your Internet service provider (ISP). See your ISP and router documentation for instructions on how to change the default password and better secure your network.

• **Connect your product only to a network protected by a firewall**
  Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead, connect it to a router or other network connection protected by a firewall. Your router may already have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best results, set up and use a private IP address for your network connection.

• **Change the default administrator password on your product**
  If your product has an option to set an administrator password, change the default administrator password to deter access by unauthorized users to personal data stored on your product, such as IDs, passwords, and contact lists.

Parent topic: Wi-Fi Networking
Wi-Fi Infrastructure Mode Setup
You can set up your product to communicate with your computer using a wireless router or access point. The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2 Wireless router or access point
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings from the Control Panel

Parent topic: Wi-Fi Networking
Selecting Wireless Network Settings from the Control Panel

You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions in the Quick Guide and install the necessary software. The installer program guides you through network setup.

1. From the home screen, select Wi-Fi Setup and press the OK button.
   
   You see this screen:

   ![Network Setup Screen]

   2. Select Wi-Fi (Recommended) and press the OK button twice.

   3. Select Wi-Fi Setup Wizard and press the OK button.

   4. Do one of the following:

   • Press the OK button to select the wireless network displayed.

   • Press the arrow buttons to select the name of your wireless network and press the OK button. If you do not see your wireless network's name, you can enter it manually.

   Note: To enter the wireless network name manually, select Other SSID and press the OK button. Enter your network name as described in the next step.
5. If you see the following screen, enter your wireless password (or network name and then password).

![Enter Password screen]

- Press the arrow buttons to highlight a letter or function button and press the **OK** button to select it.
- Select **A1#** to enter uppercase letters, numbers, or symbols.
- When you finish entering characters, select **OK**.

**Note:** The network name and password are case sensitive. Be sure to correctly enter uppercase and lowercase letters, and numeric or special characters.

6. If you want to print a network setup report, press the **OK** button. (Otherwise, press the **cancel** button.)

Your product should now be connected to the network.

**Note:** If the Wi-Fi status icon does not appear on the LCD screen, you may have selected the wrong network name or entered the password incorrectly. Repeat these steps to try again.

**Parent topic:** Wi-Fi Infrastructure Mode Setup

**Related topics**

Changing or Updating Network Connections
Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without requiring a wireless router or access point.

1  Epson product
2  Computer with a wireless interface
3  Other wireless device

Your product enters access point mode and the product itself acts as the network access point for up to 8 devices. When operating in this mode, your product displays the Wi-Fi Direct connection symbol on the LCD screen.

Note: Connected devices cannot communicate with each other via the connection to your product.

Connecting to a Mobile Device
Enabling Wi-Fi Direct Mode (Simple AP)
Modifying the Wi-Fi Direct Network Name or Password

Parent topic: Wi-Fi Networking

Related tasks
Accessing the Web Config Utility
Connecting to a Mobile Device

You can connect a mobile device directly to your product without a wireless router or access point.

**Note:** Make sure the Epson iPrint Mobile app is installed on your mobile device before connecting to the product.

1. From the home screen, select **Wi-Fi Setup** and press the **OK** button.
   
   You see this screen:

   ![Wi-Fi Setup Screen](image)

2. Select **Wi-Fi Direct** and press the **OK** button.
3. Press the **OK** button when you see the message screens.
4. Do one of the following:
   - For iOS devices, select **iOS** and press the **OK** button. Scan the QR code with the camera app on your device and follow the instructions on your device. Press the **OK** button.
   - For Android devices, select **Android** and press the **OK** button. Open the Epson iPrint app on your device and select the product you want to connect to. Select **Approve** and press the **OK** button.
   - For other types of devices, select **Other OS Devices**. Use your device to select the Wi-Fi network name (SSID) displayed on the LCD screen, then enter the password shown.
5. Follow the instructions on the LCD screen to complete Wi-Fi Direct setup.

**Parent topic:** [Wi-Fi Direct Mode Setup](#)
Enabling Wi-Fi Direct Mode (Simple AP)

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or other devices without a wireless router or access point.

To change the Wi-Fi Direct network name or password, follow the link at the end of this topic.

1. From the home screen, select **Wi-Fi Setup** and press the **OK** button.
   
   You see this screen:

2. Press the arrow buttons to select **Wi-Fi Direct** and press the **OK** button.

3. Press the **OK** button twice.

4. Press the arrow buttons to display **Other OS Devices** and press the **OK** button.

5. Press the down arrow button to see the Wi-Fi Direct network name and password.

6. Press the **OK** button twice to exit.

   You see the **AP** connection symbol on the LCD screen and should be able to print directly to your product from your computer or device.

   **Note:** If the **AP** connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode is not enabled. Repeat these steps to try again.

To disable Wi-Fi Direct, follow the steps above to display **Other OS Devices** and press the down arrow button. Press the left or right arrow button to select **Disable Wi-Fi Direct** and press the **OK** button twice. Press the **OK** button again to return to the main menu.

**Parent topic:** [Wi-Fi Direct Mode Setup](#)
Modifying the Wi-Fi Direct Network Name or Password

You can modify the Wi-Fi Direct name and password to create a more descriptive and secure Wi-Fi Direct network. You can also change the frequency range or reset the WiFi Direct settings, if necessary.

1. From the home screen, select **Wi-Fi Setup** and press the **OK** button.

   You see this screen:

   ![Image of Wi-Fi Setup screen]

2. Press the arrow buttons to select **Wi-Fi Direct** and press the **OK** button.

3. Press the **OK** button again.

4. Press the down arrow button and do one of the following:
   
   • To change the Wi-Fi Direct network name, select **Change Network Name** and press the **OK** button. Press the right arrow button to display the network name entry screen. Hold down the left arrow button to erase the current name, then follow the on-screen instructions to enter the new network name.

   • To change the Wi-Fi Direct password, select **Change Password** and press the **OK** button. Hold down the left arrow button to erase the current password, then follow the on-screen instructions to enter your new Wi-Fi Direct password.

     **Note:** Your password must be at least 8 and no more than 22 characters long. If you have already connected devices or computers to your product via Wi-Fi Direct, they will be disconnected when you change the network name or password.

   • To change the frequency range of your network connection, select **Change Frequency Range** and press the **OK** button. Select **2.4 GHz** or **5 GHz** and press the **OK** button.
Note: If you have already connected devices or computers to your product via Wi-Fi Direct, they will be disconnected when you change the frequency range. You cannot re-connect from devices that do not support 5 GHz frequency range when changing to 5 GHz.

- To restore all Wi-Fi Direct settings to their factory defaults, select Restore Default Settings and press the OK button.

Parent topic: Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

Using WPS to Connect to a Network

Parent topic: Wi-Fi Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to connect your product to the network.

1. Press the WPS button on your router.
2. From the home screen, select Wi-Fi Setup and press the OK button.

You see this screen:
3. Select **Wi-Fi (Recommended)** and press the **OK** button.
4. Press the arrow buttons to select **Push Button Setup (WPS)** and press the **OK** button.
5. Follow the instructions on the LCD screen to complete WPS setup.
   
   Your product should now display a Wi-Fi symbol on the LCD screen.

**Parent topic:** Wi-Fi Protected Setup (WPS)

### Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have using your product on a network.

1. From the home screen, select **Menu** and press the **OK** button.
2. Press the arrow buttons to select **Network Settings** and press the **OK** button.
   
   You see this screen:

   ![Network Settings Screen]

3. Press the **OK** button.
4. Press the **OK** button to print the network status sheet.
   
   (Press the ☐️ cancel button if you want to cancel the operation.)

Examine the settings shown on the network status sheet to diagnose any problems you have.

**Parent topic:** Wi-Fi Networking

**Related tasks**

**Accessing the Web Config Utility**
Printing a Network Connection Report

You can print a network connection report to view solutions to any problems you may have using your product on a network.

1. From the home screen, select **Menu** and press the **OK** button.
2. Press the arrow buttons to select **Network Settings** and press the **OK** button.
   
   You see this screen:

   ![Network Settings Screen]

3. Press the arrow buttons to select **Connection Check** and press the **OK** button.
4. Press the **OK** button to print the network connection report.

Examine the error codes and solutions shown on the network connection report.

**Network Connection Report Codes and Messages**

**Parent topic:** Wi-Fi Networking
Network Connection Report Codes and Messages

Check the error codes and messages on the network connection report to solve problems you may encounter with network connections. The tables here list solutions to problems based on the error codes and messages that may appear on the top of the report.

1. Error code
2. Message

Note: Error codes and messages listed here may not all apply to your product.

Error Codes and Messages

<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-1</td>
<td>Make sure your router, access point, and/or hub are turned on, and the network cable is securely connected to your device and to your product. If you are trying to set up Wi-Fi, remove the network cable and set up Wi-Fi again. Ethernet and Wi-Fi cannot be connected at the same time.</td>
</tr>
<tr>
<td></td>
<td>Confirm that the network cable is connected and network devices such as hub, router, or access point are turned on.</td>
</tr>
<tr>
<td>Error code and message</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| E-2, E-3, or E-7       | Check the following:  
|                        | • Make sure your router or access point is turned on, and is correctly connected to your computer or network device.  
|                        | • Turn off the router or access point, wait about 10 seconds, and turn it on again.  
|                        | • Move your product closer to your router or access point, and remove any obstacles between them. Also move your product away from devices such as wireless phones or microwaves.  
|                        | • Confirm that the SSID shown on the network connection report matches the label on your router or access point. Also make sure your SSID uses only ASCII characters and symbols, or your product cannot display the SSID correctly.  
|                        | • If you are trying to connect using the WPS push button method, make sure your router or access point supports it.  
|                        | • If you are using a network password, check the label on your router or access point to confirm that you are using the correct password, or check with your network administrator or router/access point documentation.  
|                        | • If you are connecting to a smart device that generates an SSID, check the device documentation for the SSID and password you should use.  
|                        | • If your wireless connection suddenly disconnects, and another smart device was added to the network using a WPS push button method or your network was set up using a non-WPS push button method, try downloading and installing your product software again.  

No wireless network names (SSID) found. Confirm that the router/access point is turned on and the wireless network (SSID) is set up correctly. Contact your network administrator for assistance.

No wireless network names (SSID) found. Confirm that the wireless network name (SSID) of the PC you wish to connect is set up correctly. Contact your network administrator for assistance.

Entered security key/password does not match the one set for your router/access point. Confirm security key/password. Contact your network administrator for assistance.
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
</table>
| **E-5**                | If the security on your router or access point is not one of the following types, change the type of security on your router or access point and reset your product's network settings.  
• WEP-64 bit (40 bit)  
• WEP-128 bit (104 bit)  
• WPA PSK (TKIP/AES); also known as WPA Personal  
• WPA2 PSK (TKIP/AES); also known as WPA2 Personal  
• WPA (TKIP/AES)  
• WPA2 (TKIP/AES) |
| **E-6**                | If your router or access point has MAC address filtering enabled, register your product's MAC address so it is not filtered. Locate the MAC address on the network connection report and check your router or access point documentation for instructions.  
If your router or access point is using shared authentication with WEP security, confirm that you are using the correct authentication key and index.  
If your router or access point limits the number of connected devices, raise the connection limit. See your router or access point documentation for instructions. |
| **E-8**                | If your product's Obtain IP Address setting is set to Auto, enable DHCP on your router or access point. If it is set to Manual, the IP address may be out of range or on a different network segment; set a valid IP address using your product control panel or the Web Config utility.  
You can also try turning off your product and the router or access point, waiting about 10 seconds, and turning them on again. |
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>E-9</strong>&lt;br&gt;Confirm the connection and network setup of the PC or other device. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance.</td>
<td>Make sure your computer or network device are turned on. Also make sure that you can access the Internet and other devices on the same network from the devices you are trying to connect to your product.&lt;br&gt;If you still cannot connect to your product, turn off your router or access point, wait about 10 seconds, and turn it on again. Download and install your product software again to reset your network settings.</td>
</tr>
<tr>
<td><strong>E-10</strong>&lt;br&gt;Confirm IP address, subnet mask, and default gateway setup. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance.</td>
<td>Make sure other devices on the network are turned on and do the following:&lt;br&gt;• If your product's <strong>Obtain IP Address</strong> setting is set to <strong>Manual</strong>, check the IP address, subnet mask, and default gateway addresses on the network connection report to see if they are correct. If not, correct the settings.&lt;br&gt;• If DHCP is enabled, set your product's <strong>Obtain IP Address</strong> setting to <strong>Auto</strong>. If you want to use the DHCP-assigned address as a static address, set the <strong>Obtain IP Address</strong> setting to <strong>Manual</strong>, enter the product's IP address as listed on the network connection report, and set the subnet mask to 255.255.255.0.&lt;br&gt;If you still cannot connect to your product, turn off your router or access point, wait about 10 seconds, and turn it on again.</td>
</tr>
<tr>
<td><strong>E-11</strong>&lt;br&gt;Setup is incomplete. Confirm default gateway setup. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance.</td>
<td>If you set your product's <strong>TCP/IP Setup</strong> setting to <strong>Manual</strong>, check that the default gateway address listed on the network connection report is correct. Also turn on the device that is set as the default gateway.</td>
</tr>
<tr>
<td>Error code and message</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| **E-12**               | Make sure other devices on the network are turned on and do the following:  
- Make sure the IP address, subnet mask, and default gateway addresses are correct, if you are entering them manually.  
- Confirm that the subnet mask and default gateway addresses for other devices are the same.  
- Make sure the IP address does not conflict with other devices.  
If you still cannot connect to your product, do the following:  
- Turn off your router or access point, wait about 10 seconds, and turn it on again.  
- Download and install your product software again to reset your network settings.  
- If your router or access point uses WEP security with several registered passwords, make sure that the first registered password is set on your product. |
| **E-13**               | Make sure your router, access point, and/or hub are turned on. Also make sure the TCP/IP setup on your router, access point, and/or hub is not set manually; this may cause your product's network settings to differ from the manually set up devices.  
If you still cannot connect to your product, do the following:  
- Turn off your router or access point, wait about 10 seconds, and turn it on again.  
- Download and install your product software again to reset your network settings.  
- If your router or access point uses WEP security with several registered passwords, make sure that the first registered password is set on your product. |

Confirm the following  
- Entered security key/password is correct  
- Index of the security key/password is set to the first number  
- IP address, subnet mask, or default gateway setup is correct  
Contact your network administrator for assistance.
### Network Environment Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Wi-Fi environment needs to be improved. Turn the wireless router off and then turn it on. If the connection does not improve, see the documentation for the wireless router.</td>
<td>Move your product closer to your router or access point, and remove any obstacles between them. Then turn off your router or access point, wait about 10 seconds, and turn it back on again. If you still cannot connect to your product, check the documentation that came with your router or access point for solutions.</td>
</tr>
<tr>
<td><em>No more devices can be connected. Disconnect one of the connected devices if you want to add another one.</em></td>
<td>You can connect up to 8 computers or other devices to your product using a Wi-Fi Direct (Simple AP) connection. If you want to add another device, disconnect an existing connected device first.</td>
</tr>
<tr>
<td>The same SSID as Wi-Fi Direct exists in the environment. Change the Wi-Fi Direct SSID if you cannot connect a smart device to the printer.</td>
<td>Change the Wi-Fi Direct SSID.</td>
</tr>
</tbody>
</table>

Parent topic: Printing a Network Connection Report

### Changing or Updating Network Connections

See these sections to change or update how your product connects to a network.

- [Accessing the Web Config Utility](#)
- [Changing a USB Connection to a Wi-Fi Connection](#)
- [Connecting to a New Wi-Fi Router](#)
- [Disabling Wi-Fi Features](#)

Parent topic: Wi-Fi Networking

Related tasks:

- [Selecting Wireless Network Settings from the Control Panel](#)

### Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser. You do this by accessing your product's built-in Web Config utility from a computer or other device that is connected to the same network as your product.

1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web browser.
4. Enter your product's IP address into the address bar.
   You see the available Web Config utility options.

Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions in the Quick Guide.

Parent topic: Changing or Updating Network Connections

Related concepts
Uninstall Your Product Software

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your product's Wi-Fi connection to the new router.

1. Do one of the following:
   • **Windows**: Uninstall your product software.
   • **Mac**: Go to the next step.
2. Download and install your product software from the Epson website using the instructions in the Quick Guide.

Parent topic: Changing or Updating Network Connections

Related concepts
Uninstall Your Product Software
Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or need to solve a problem with your network connection.

**Note:** Before disabling Wi-Fi features, make a note of your product's SSID (network name) and password, and any network settings selected for the Epson Connect services you may use.

1. From the home screen, select **Wi-Fi Setup** and press the **OK** button.
   
   You see this screen:

   ![Stop Wi-Fi Signal](image)

   ![OK Proceed](image)

2. Press the **OK** button.
3. When you see the confirmation message, press the **OK** button to disable Wi-Fi.

**Parent topic:** Changing or Updating Network Connections
Loading Paper

Before you print, load paper for the type of printing you will do.
Loading Paper and Envelopes
Selecting the Paper Source Settings - Control Panel
Turning Off the Paper Setting Alert
Paper Loading Capacity
Compatible Epson Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings - Printing Software

Loading Paper and Envelopes

You can load envelopes and paper up to this size in the rear paper feed: Legal (8.5 × 14 inches [216 × 356 mm]).

1. Lift up and open the printer cover.

2. Slide the edge guide to the left.
3. Do one of the following:
   • Load paper in the rear paper feed behind the tabs, with the glossy or printable side faceup.

   ![Image of paper loading]

   • Load an envelope with the flap edge facedown and to left, as shown.

   ![Image of envelope loading]
• Load one sheet of hole-punched paper as shown.

4. Slide the edge guide against the paper, but not too tightly.
5. Select the size and type of paper you loaded on the product LCD screen. Always follow these paper loading guidelines:
   • Load only the recommended number of sheets.
   • Load paper short edge first and printable side faceup.
   • If you have trouble loading an envelope, press it envelope flat before loading it.
   • Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references
Paper Loading Capacity
Paper Specifications

Selecting the Paper Source Settings - Control Panel
You can change the default paper size and paper type using the control panel on the product.

1. From the home screen, select **Menu** and press the **OK** button.
2. Press the arrow buttons to select **Printer Setup** and press the **OK** button.
You see this screen:

3. Select **Paper Source Settings** and press the **OK** button.

   **Note:** To turn off automatic display of the paper settings screen after you load paper in the product, set the **Paper Configuration** setting to **Off**. If you do this, you will not be able to use AirPrint.

4. Select **Paper Setup** and press the **OK** button.
5. Select **Paper Size** and press the **OK** button.
6. Select the paper size you loaded and press the **OK** button.
7. Select **Paper Type** and press the **OK** button.
8. Select the paper type you loaded and press the **OK** button.

**Paper or Media Type Settings - Control Panel**

**Parent topic:** Loading Paper

**Related references**

**Paper or Media Type Settings - Printing Software**
Paper or Media Type Settings - Control Panel

<table>
<thead>
<tr>
<th>Paper</th>
<th>Select this Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Bright White Pro Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Prem. Semi-Gloss</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Prem. Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>

Parent topic: Selecting the Paper Source Settings - Control Panel

Turning Off the Paper Setting Alert

The Paper Setting Alert warns you when the paper settings do not match the paper you loaded. You can turn off this feature from the product's control panel.

1. From the home screen, select Menu and press the OK button.
2. Press the arrow buttons to select Printer Setup and press the OK button.
You see this screen:

3. Select **Paper Source Settings** and press the **OK** button.
4. Press the arrow buttons to select **Paper Setting Alert** and press the **OK** button.
5. Select **Off** and press the **OK** button.

**Parent topic:** Loading Paper

### Paper Loading Capacity

See the table here for the loading capacity of the product.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), B5 (7.2 × 10.1 inches [182 × 257 mm]), A5 (5.8 × 8.2 inches [148 × 210 mm]), and A6 (4.1 × 5.8 inches [105 × 148 mm]) sizes</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Copy paper</td>
<td>Legal (8.5 × 14 inches [216 × 356 mm]) size and User-defined sizes</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Epson Bright White Pro Paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper type</td>
<td>Size</td>
<td>Loading capacity</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), 4 × 6 inches (102 × 152 mm), 5 × 7 inches (127 × 178 mm), and 16:9 wide (4 × 7.1 inches [102 × 181 mm]) sizes</td>
<td>5 sheets (1 sheet if paper feed problems occur)</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]) size</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Envelopes</td>
<td>—</td>
<td>1 envelope</td>
</tr>
</tbody>
</table>

**Parent topic:** Loading Paper

**Related references**

Paper Specifications

**Compatible Epson Papers**

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Pro Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042180</td>
<td>100</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041809, S042038</td>
<td>50, 100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041141, S041649, S041271</td>
<td>20, 50, 100</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041808, S041727</td>
<td>40, 100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042183, S041667</td>
<td>25, 50</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S042181, S042174</td>
<td>60, 100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042182, S042175</td>
<td>25, 50</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041331</td>
<td>20</td>
</tr>
</tbody>
</table>

**Parent topic:** Loading Paper

**Borderless Paper Type Compatibility**

You can print borderless photos on compatible paper types in compatible sizes:

**Borderless Paper Types**

- Epson Photo Paper Glossy
• Epson Premium Photo Paper Glossy
• Epson Ultra Premium Photo Paper Glossy
• Epson Premium Photo Paper Semi-gloss

**Borderless Paper Size**
• 4 × 6 inches (102 × 152 mm)

**Parent topic:** Loading Paper

---

**Paper or Media Type Settings - Printing Software**

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Copy paper</td>
<td></td>
</tr>
<tr>
<td>Epson Bright White Pro Paper</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>

**Parent topic:** Loading Paper
Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software as described in the Quick Guide.

Even if you have not installed the software, you can still print from a Windows computer using the built-in basic driver.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website. If you see a Software Update screen, select *Enable automatic checking* and click OK. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

**Caution:** If you are using the AC adapter, do not disconnect it while the product is operating. Printing may slow down, which can cause a paper jam.

- Printing with the Standard Epson Printer Software - Windows
- Printing with the Built-in Basic Driver - Windows
- Printing with the Built-in Epson Driver - Windows 10 S
- Printing on a Mac
- Canceling Printing Using a Product Button

## Printing with the Standard Epson Printer Software - Windows

You can print with the standard Epson printer software using any Windows printing program, as described in these sections.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

- Selecting Basic Print Settings - Windows
- Selecting Double-sided Printing Settings - Windows
- Selecting Additional Layout and Print Options - Windows
- Selecting a Printing Preset - Windows
- Selecting Extended Settings - Windows
- Printing Your Document or Photo - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   Note: You may also need to select Properties or Preferences to view your print settings.
You see the Main tab of your printer settings window:

4. Select the size of the paper you loaded as the **Document Size** setting.

5. Select the orientation of your document.

   **Note:** If you are printing an envelope, select **Landscape**.

6. Select the type of paper you loaded as the **Paper Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

7. Select the **Quality** setting that matches the print quality you want to use.

8. Select a Color option:
   - To print a color document or photo, select the **Color** setting.
To print text and graphics in black or shades of gray, select the **Black/Grayscale** setting.

9. To print on both sides of the paper, select a **2-Sided Printing** option.

10. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select one of the settings in the **Multi-Page** menu and select the printing options you want.

11. To print multiple copies and arrange their print order, select the **Copies** options.

12. To preview your job before printing, select **Print Preview**.

**Print Quality Options - Windows**

**Multi-Page Printing Options - Windows**

**Parent topic:** [Printing with the Standard Epson Printer Software - Windows](#)

**Related references**

- [Paper or Media Type Settings - Printing Software](#)
- [Related tasks](#)
  - [Selecting Double-sided Printing Settings - Windows](#)
  - [Printing Your Document or Photo - Windows](#)

**Print Quality Options - Windows**

You can select any of the available Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

- **Draft**
  - For draft printing on plain paper.

- **Standard**
  - For everyday text and image printing.

- **High**
  - For photos and graphics with high print quality.

**Parent topic:** [Selecting Basic Print Settings - Windows](#)

**Multi-Page Printing Options - Windows**

You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

- **2-Up and 4-Up**
  - Prints 2 or 4 pages on one sheet of paper. Click the **Page Order** button to select page layout and border options.

- **2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster**
  - Prints one image on multiple sheets of paper to create a larger poster. Click the **Settings** button to select image layout and guideline options.
Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main tab.

![2-Sided Printing settings](image)

**Note:** You will need to print one side and flip the paper over manually to print the other side.

**Note:** Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
   - **Manual (Long-edge binding)** to print your double-sided print job by printing one side and prompting you to flip the paper over on the long edge to print the other side.
   - **Manual (Short-edge binding)** to print your double-sided print job by printing one side and prompting you to flip the paper over on the short edge to print the other side.

2. Click the Settings button.
You see a window like this:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
5. Print a test copy of your double-sided document to test the selected settings.
6. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows

Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows

You can select any of the available options on the Binding Settings window to set up your double-sided print job.
Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Booklet
Select the Booklet checkbox to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows

Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More Options tab.
1. To change the size of your printed document or photo, select the Reduce/Enlarge Document checkbox and select one of these sizing options:
   - Select the **Fit to Page** option to size your image to fit the paper you loaded. Select the size of your document or photo as the **Document Size** setting, and the size of your paper as the **Output Paper** setting. If you want to center your image on the paper, select the **Center** option.
   - Select the **Zoom to** option to reduce or enlarge your document or photo by a specific percentage. Select the percentage in the % menu.

2. Select one of the following Color Correction options:
   - Select **Automatic** to automatically adjust the sharpness, brightness, contrast, and color saturation for your image.
   - Select **Custom** and click the **Advanced** button to manually adjust the color correction settings or turn off color management in your printer software.
   - Select **Image Options** to access additional settings for improving printed images.

3. To add the following features, click the **Watermark Features** button:
   - **Watermark**: adds a visible watermark to your printout
   - **Header/Footer**: adds information such as the date and time to the top or bottom of your printout

   **Note**: Click the **Settings** button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.

   - **Custom Color Correction Options - Windows**
   - **Image Options and Additional Settings - Windows**
   - **Header/Footer Settings - Windows**

**Parent topic**: Printing with the Standard Epson Printer Software - Windows

**Related tasks**

- **Printing Your Document or Photo - Windows**
Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors for your print job.

![Color Correction Window](image)

**Color Controls**

Lets you select a **Color Mode** setting, individual settings for **Brightness**, **Contrast**, **Saturation**, and **Density**, and individual color tones. Depending on the selected color mode, you can also adjust the midtone density using the **Gamma** setting.

**Fix Photo**

Improves the color, contrast, and sharpness of flawed photos.

**Note:** Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.
ICM  
Lets you manage color using installed color printing profiles.

No Color Adjustment  
Turns off color management in your printer software so you can manage color using only your application software.

Parent topic: Selecting Additional Layout and Print Options - Windows

Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some options may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options

Emphasize Text  
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines  
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing  
Smoothes jagged edges in low-resolution images such as screen captures or images from the Web.

Fix Red-Eye  
Reduces or removes red-eye in photos.

Print Text in Black  
Prints colored text in black.

For Color Text  
Prints colored text on a background pattern or underlined.

For Color Graphs and Images  
Prints colored graphics and images with overlay patterns.

For Color Text, Graphs, and Images  
Prints colored text, graphics, and images with overlay patterns.

Enhancement Options  
Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options

Rotate 180º  
Prints the image rotated 180º from its original orientation.
High Speed
- Speeds up printing but may reduce print quality.

Mirror Image
- Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows

Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The items are available to print at the top or bottom of your pages, in either the left, right, or center of the page.

Note: These settings are not saved with your document.
You can select to print the following information:

- User Name
- Computer Name
- Date
- Date/Time
- Document Name
- Collate Number
- Text

**Note:** The user name, computer name, date, and time come from the Windows Control Panel on your computer.

**Parent topic:** [Selecting Additional Layout and Print Options - Windows](#)

**Selecting a Printing Preset - Windows**

For quick access to common groups of print settings, you can select a printing preset on the **Main** or **More Options** tab.

**Note:** You can create your own preset by clicking the **Add/Remove Presets** button.

1. Click the **Main** or **More Options** tab.
You see the available **Printing Presets** on the left:

2. Place your cursor over one of the **Printing Presets** to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control your printing presets.
4. To choose a preset for printing, select it.
5. Click **OK**.
Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select Printer Settings.
3. Click the Maintenance tab.
   You see the maintenance options:

4. Click the Extended Settings button.
You see this window:

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.

Parent topic: Printing with the Standard Epson Printer Software - Windows

Extended Settings - Windows

You can select these settings on the Extended Settings window.

Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.
Check Paper Width Before Printing
Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print speed.

Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Barcode mode
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper, preprinted paper, envelopes, and thick paper.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.

1. Click OK to save your settings.
You see your application's Print window, such as this one:

![Print window](image)

2. Click **OK** or **Print** to start printing.

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

### Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the **printer** icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.

2. Select **Printer Settings**.
You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

Changing the Language of the Printer Software Screens

Parent topic: Printing with the Standard Epson Printer Software - Windows

Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select Printer Settings.
You see the printer settings window.

3. Click the **Maintenance** tab.

You see the maintenance options:

4. Select the language you want to use as the **Language** setting.

5. Click **OK** to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.

**Parent topic:** Selecting Default Print Settings - Windows

### Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.
1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.

2. Select **Software Update Settings**.

   You see this window:

   ![Software Update Settings window](image)

3. Do one of the following:
   - To change how often the software checks for updates, select a setting in the **Check every** menu.
   - To disable the automatic update feature, select the **Never** option.

4. Click **OK** to exit.

   **Note:** If you choose to disable the automatic update feature, you can check for updates manually.

**Parent topic:** Printing with the Standard Epson Printer Software - Windows

**Related tasks**

- Checking for Software Updates

**Printing with the Built-in Basic Driver - Windows**

You can print from any Windows computer, even if you do not have the product CD or an Internet connection, as described in these sections.

**Installing the Basic Driver Software - Windows**

**Selecting Print Settings - Windows Basic Driver**
Installing the Basic Driver Software - Windows

You can use the included USB cable to connect the product to your computer and install the basic driver from the product itself.

1. Make sure the product is not connected to the computer.
2. On the product's control panel, select **Menu** and press the **OK** button.
3. Use the arrow buttons to select **EC-C110 Basic Driver** and press the **OK** button.
4. Follow the instructions on the LCD screen to connect the product and computer using the micro USB cable and press the **OK** button.

5. Go to **Computer**, **My Computer**, or **This PC** on the computer and double-click **EPSON > SETUP**.
6. Follow the on-screen instructions to complete the installation.

Parent topic: Printing with the Built-in Basic Driver - Windows

Selecting Print Settings - Windows Basic Driver

Select the settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select **Properties** or **Preferences** to view your print settings.

   You see the Layout tab of your printer settings window:

4. Select the orientation of your document.

   **Note:** If you are printing an envelope, select **Landscape**.

5. Select the page order and format for your document.

6. Click the **Paper/Quality** tab.
You see this screen:

7. Select the type of paper you loaded as the **Media** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

8. Select a Color option:
   - To print text and graphics in black or shades of gray, select the **Black & White** setting.
   - To print a color document or photo, select the **Color** setting.

9. Click **Advanced**.
You see this screen:

![EPSON Advanced Options](image)

10. Select the size of the paper you loaded as the **Paper Size** setting.
11. Click **OK** to save your settings.
12. On the next screen, click **OK** or **Print** to start printing.

**Parent topic:** Printing with the Built-in Basic Driver - Windows

**Related references**

Paper or Media Type Settings - Printing Software

**Related tasks**

Adjusting Print Density

Adjusting Color
Adjusting Print Density

You can increase print density to darken your prints on plain paper. This is especially useful when you print with the built-in basic driver, which does not include density adjustment settings.

**Note:** Increasing density may reduce print speed.

1. From the home screen, select **Menu** and press the **OK** button.
   You see this screen:

   ![Menu Screen](image)

2. Press the arrow buttons to select **Plain Paper Density Setting** and press the **OK** button.
   You see this screen:

   ![Plain Paper Density Screen](image)

3. Press the arrow buttons to select +1 or +2 and press the **OK** button.
Adjusting Color

You can use the product's control panel to lighten or darken the colors in your prints. This is especially useful when you print with the built-in basic driver, which does not include color adjustment settings.

1. From the home screen, select **Menu** and press the **OK** button.
   
   You see this screen:

   ![Menu Screen](image1)

2. Press the arrow buttons to select **Color Adjustment** and press the **OK** button.
   
   You see this screen:

   ![Color Adjustment Screen](image2)
3. Do one of the following:
   • To make the color darker, select +1 and press the OK button.
   • To make the color lighter, select –1 and press the OK button.

Parent topic: Printing with the Built-in Basic Driver - Windows

Printing with the Built-in Epson Driver - Windows 10 S

You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your product. To print with additional settings, download and install the Epson Print and Scan utility from the Windows Store. You cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S

Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S

Select the settings for your print job in your Windows 10 S application.

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   Note: You may also need to select Properties or Preferences to view your print settings.
You see a window like this:

4. Select the type of paper you loaded as the Media setting.

   Note: The setting may not exactly match the name of your paper. Check the paper type settings list for details.

5. Click the Advanced button.
You see a window like this:

6. Select the size of the paper you loaded as the **Paper Size** setting.
7. To print multiple copies, select or enter the number as the **Copy Count** setting.
8. To print multiple copies of multi-page documents in sets, select the **Collated** checkbox.
9. Click **OK**.
   
   You return to the printing preferences window.
10. Select the **Layout** tab.

![Epson ESC/P-R V4 Class Driver Printing Preferences](image)

11. Select the orientation of your document as the **Orientation** setting.

12. Click **OK** to save your settings.

   You see your application's **Print** window.

13. Click **OK** or **Print** to start printing.

**Parent topic:** Printing with the Built-in Epson Driver - Windows 10 S

### Printing on a Mac

You can print with your product using any Mac printing program, as described in these sections.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website.

**Selecting Basic Print Settings - Mac**
Selecting Basic Print Settings - Mac

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the Printer setting.

![Printer settings](image)

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
You see the expanded printer settings window for your product:

![Printer Settings Window](image)

**Note:** The print window may look different, depending on your version of the Mac operating system and the application you are using.

5. Select the **Copies** and **Pages** settings as necessary.

**Note:** If you do not see these settings in the print window, check for them in your application before printing.
6. Select the page setup options: **Paper Size** and **Orientation**.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Print Settings** or **Printer Features** from the pop-up menu.

   You see these settings:

   ![Print Settings](image)

   **Note:** The available print settings and appearance of the print window may be different than those covered here, depending on the Mac OS version and the application you are using.

9. Select the type of paper you loaded as the **Media Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

10. Select the **Print Quality** setting you want to use.
11. Select the **Borderless** checkbox if you want to print a borderless photo. If the option is grayed out, change the **Media Type** setting to a paper type that supports borderless printing.

12. Select any of the other available print options.

**Print Quality Options - Mac**

**Print Options - Mac**

**Parent topic:** Printing on a Mac

**Related references**

Paper or Media Type Settings - Printing Software

**Related tasks**

Selecting Page Setup Settings - Mac

Printing Your Document or Photo - Mac

**Print Quality Options - Mac**

You can select any of the available Print Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type setting you have chosen.

**Draft**

For draft printing on plain paper.

**Normal**

For everyday text and image printing.

**Fine**

For text and graphics with good quality and print speed.

**Quality**

For text and graphics with increased quality and print speed.

**High Quality**

For photos and graphics with high print quality.

**Best Quality**

For the best print quality, but the slowest print speed.

**Parent topic:** Selecting Basic Print Settings - Mac

**Print Options - Mac**

You can select any of the print options to customize your print. Some options may be unavailable, depending on other settings you have chosen.
Expansion
If you selected a borderless paper size setting, this option adjusts the image expansion settings to control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac
Depending on your application, you may be able to select the paper size and orientation settings from the print window.

Note: If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless photo, select the Borderless checkbox or a paper size with a Borderless option. You can also select a custom setting to create a custom paper size, but the Quality setting will be limited to Normal.

   Note: You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

   Note: If you are printing an envelope, select the icon.

   Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the pop-up menu and selecting a scaling option.
Selecting Print Layout Options - Mac

You can select a variety of layout options for your document or photo by selecting Layout from the pop-up menu on the print window.

- To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.
- To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
- To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Managing Color - Mac

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout or turn off color management in your printer software.
1. Select **Color Matching** from the pop-up menu in the print window.

![Color Matching Menu]

2. Select one of the available options.

3. Select **Color Options** from the pop-up menu in the print window.

![Color Options Menu]

**Note:** The available settings on the Color Options menu depend on the option you selected on the Color Matching menu.

4. Select one of the available options.

**Color Matching and Color Options - Mac**

**Parent topic:** Printing on a Mac

**Color Matching and Color Options - Mac**

You can select these settings on the **Color Matching** and **Color Options** menus.
**Color Matching Settings**

**EPSON Color Controls**
Lets you manage color using controls in your printer software or turn off color management.

**ColorSync**
Prints using standard color profiles for your product and paper to help match image colors. You can customize the conversion method and filter settings on the ColorSync pop-up menu in the print window.

**Color Options Settings**

**Manual Settings**
Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-eye in photos. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

**Fix Photo**
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

*Note:* Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

**Off (No Color Adjustment)**
Turns off color management in your printer software so you can manage color using only your application software.

*Note:* An ICC profile is required if color management is turned off.

**Parent topic:** Managing Color - Mac

---

**Selecting Printing Preferences - Mac**

You can select printing preferences that apply to all the print jobs you send to your product.

1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies.
3. Select **Driver** or **Options**.
   You see a screen like this:

![Printing preferences screen](image)

4. Select any of the available printing preferences.
5. Click **OK**.

**Printing Preferences - Mac**

**Parent topic:** Printing on a Mac

**Printing Preferences - Mac**

You can select these settings on the **Options** or **Driver** tab.

**Skip Blank Page**

Ensures that your product does not print pages that contain no text or images.
Quiet Mode
Lessens noise during printing but may decrease print speed.

Permit temporary black printing
Allows you to print using black ink when color ink is expended.

High Speed Printing
Speeds up printing but may reduce print quality.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.
Click **Print** at the bottom of the print window.
Checking Print Status - Mac

Parent topic: Printing on a Mac

Related references
Printing Preferences - Mac

Related tasks
Selecting Basic Print Settings - Windows
Selecting Page Setup Settings - Mac
Selecting Print Layout Options - Mac

Checking Print Status - Mac

During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock.

   You see the print status window:

   ![Print status window](image)

2. Select the following options as necessary for your Mac OS version:
   
   • To cancel printing, click the print job and click or Delete.
   
   • To pause a print job, click the print job and click or Hold. To resume a print job, click the paused print job and click or Resume.
   
   • To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click **Settings** or **Supply Levels**.

**Parent topic:** Printing Your Document or Photo - Mac

## Cancelling Printing Using a Product Button

If you need to cancel printing, press the 🚫 cancel button on your product.

**Parent topic:** Printing from a Computer
Replacing Ink Cartridges and Maintenance Boxes

The maintenance box stores ink that gets flushed from the system during print head cleaning. When an ink cartridge is expended or the maintenance box is at the end of its service life, you need to replace it.

You may also need to replace a cartridge that is more than six months old if your printouts do not look their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly and in accordance with local requirements. If you would like to return your used ink cartridges and maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing Ink Cartridges
Printing with Black Ink and an Expended Color Cartridge
Conserving Low Black Ink with Windows
Replacing the Maintenance Box

Check Cartridge and Maintenance Box Status

Your product and its software will let you know when an ink cartridge is low or expended, or when the maintenance box needs to be replaced.

Checking Cartridge and Maintenance Box Status on the LCD Screen
Checking Cartridge and Maintenance Box Status - Windows
Checking Cartridge and Maintenance Box Status - Mac

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Checking Cartridge and Maintenance Box Status on the LCD Screen

You can check the status of your ink cartridges and maintenance box on your product's LCD screen.

If necessary, press the \( \text{cancel} \) button to return to the home screen.
The ink and maintenance box status is displayed as shown:

![Image of ink and maintenance box status]

**Note:** The displayed levels are approximate.

**Parent topic:** Check Cartridge and Maintenance Box Status

**Related tasks**
- Removing and Installing Ink Cartridges
- Replacing the Maintenance Box

### Checking Cartridge and Maintenance Box Status - Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge or maintenance box status at any time using a utility on your Windows computer.

**Note:** You can continue printing while the low ink message is displayed. Replace the ink cartridges when required.

1. To check your status, access the Windows Desktop and double-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and double-click . Then click **Details**.
You see this window:

2. Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

   **Note:** If any of the cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

3. To disable the low ink reminder, right-click the product icon in the Windows taskbar and select **Monitoring Preferences**.
You see this window:

4. Deselect the **See Low Ink Reminder alerts** checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the **Display Epson Offers** checkbox.
6. Click **OK**.

**Parent topic:** Check Cartridge and Maintenance Box Status
Related tasks
Removing and Installing Ink Cartridges
Replacing the Maintenance Box

Checking Cartridge and Maintenance Box Status - Mac

You can check the status of your ink cartridges and maintenance box using a utility on your Mac.

**Note**: You can continue printing while the low ink message is displayed. Replace the ink cartridges when required.

1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
2. Select **EPSON Status Monitor**.
3. Do the following as necessary:
   • You can update the ink cartridge and maintenance box status by clicking **Update**.
   • Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

   **Note:** If any of the cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

**Parent topic:** Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

**Note:** Your printer is designed to work only with genuine Epson-brand ink cartridges. Other brands of ink cartridges and ink supplies are not compatible and, even if described as compatible, may not function properly at all. Epson periodically provides firmware updates to address issues of security, performance, minor bug fixes and ensure the printer functions as designed. These updates may affect the functionality of third-party ink. Non-Epson branded or altered Epson cartridges that functioned prior to a firmware update may not continue to function.

The included initial cartridges are designed for reliable printer setup and cannot be used as replacement cartridges or resold. After setup, the remaining ink is available for printing. Yields are based on ISO 24711 in default mode, printing continuously. Yields vary due to print images, settings, and temperatures. Printing infrequently or primarily with one color reduces yields. All cartridges must be installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced cartridges.

**Ink Cartridge and Maintenance Box Part Numbers**

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes

**Ink Cartridge and Maintenance Box Part Numbers**

Use these part numbers when you order or purchase a new maintenance box or ink cartridges.

Maintenance box part number: T2950

**Note:** For best printing results, use up a cartridge within 6 months of opening the package.

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>215</td>
</tr>
<tr>
<td>Tri-Color</td>
<td>215</td>
</tr>
</tbody>
</table>
Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new cartridges immediately after removing the old ones.

**Caution:** Leave your old cartridges in the printer until you are ready to replace them to prevent the print head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

1. Turn on your product.
   - If an ink cartridge is expended, you see a message on the LCD screen. Note which cartridges need to be replaced and press the **OK** button. Select the option to replace the ink cartridge and press the **OK** button.
   - If you are replacing a cartridge before you see a message on the LCD screen, select **Menu > Maintenance > Ink Cartridge Replacement.** Then press the **OK** button.

2. Open the inner cover.

**Caution:** Do not move the print head by hand; otherwise, you may damage your product. Do not touch the flat white cable inside the printer.
3. Push in the blue tab to unlock the ink cartridge you are replacing. Then lift the bottom of the ink cartridge as shown to remove it.

**Warning:** If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep ink cartridges out of the reach of children.

4. Recap the used ink cartridge using the cap that came with it.

**Note:** Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.
5. Remove the new ink cartridge from the package and remove the yellow tape.

**Caution:** Do not touch the areas shown below. Doing so may prevent normal operation and printing.

6. Remove the cap from the cartridge and store it so you can recap the ink cartridge before storing or disposing of it.

**Caution:** Do not remove any other labels or seals, or ink will leak.
7. Insert the ink cartridge at a slight angle into the ink cartridge holder as shown. Then press the ink cartridge down until it clicks into place.

8. After you replace the cartridge or cartridges that need replacing, close the inner cover and press the OK button.

The product starts charging the ink. This takes a few minutes. When you see a completion message on the LCD screen, ink replacement is complete.

**Note:** Do not turn off the product while it is charging or you will waste ink. If you see an error screen telling you an ink cartridge is installed incorrectly, open the inner cover and press the ink cartridge down until it clicks into place. When you're finished, close the inner cover.

If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.

**Caution:** If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink. Store the ink cartridge in the same environment as the product. Do not leave the product with the ink cartridges removed for an extended period of time. Otherwise, ink remaining in the print head nozzles may dry out and you may not be able to print.

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes

**Related concepts**

Purchase Epson Ink Cartridges and Maintenance Box

**Printing with Black Ink and an Expended Color Cartridge**

When the color ink cartridge is expended, you can temporarily continue printing from your computer using black ink. Replace the expended color cartridge as soon as possible for future printing.
Printing with an Expended Color Cartridge - Windows

If you see a message during printing telling you that you can temporarily print in black ink with an
expended color cartridge, you can cancel your print job and select settings to print on plain paper or on
an envelope.

**Note:** To use this feature, Epson Status Monitor must be enabled.

1. Click **Cancel** or **Cancel Print** to cancel your print job.
2. Load plain paper or an envelope in your product.
3. Access the print settings in your print application.
4. Click the **Main** tab.
5. Select **Plain Paper/Bright White Paper** or **Envelope** as the paper type setting.
6. Select the **Black/Grayscale** checkbox.
7. Click **OK**.
8. Print your document.
   Epson Status Monitor 3 displays a print message.
9. Click **Print in Black** to print your document.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

---

Printing with an Expended Color Cartridge - Mac

If printing stops, you can cancel your print job and select settings to temporarily print with only black ink
on plain paper or on an envelope.

1. Click the printer icon in the Dock.
2. If you see a message telling you that you can temporarily print with only black ink, click the **Delete** or
   **Trash** icon to cancel your print job.
3. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or
   **Printers & Scanners**, select your product, and select **Options & Supplies**.
4. Select **Driver or Options**.
   You see a screen like this:

![Screen with options](image)

5. Select **On** as the Permit temporary black printing setting.
6. Click **OK**.
7. Close the utility window.
8. Load plain paper or an envelope in your product.
9. Access the print settings in your print application.
10. Select **Print Settings** from the pop-up menu.
11. Select **Plain Paper/Bright White Paper** or **Envelope** as the paper type setting.
12. Select the **Grayscale** option.
13. Click **Print** to print your document.

**Parent topic:** Printing with Black Ink and an Expended Color Cartridge
Conserving Low Black Ink with Windows

The following window appears when black ink runs low and there is more color ink.

![EPSON Status Monitor 3]

Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor must be enabled.

- Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink for the document you are printing.
- Click Disable this feature to continue using the remaining black ink.

Note: If you disable this feature, it remains disabled until you install a new black ink cartridge.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Replacing the Maintenance Box

Make sure you have a new maintenance box before you begin.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for more than a week. Keep the maintenance box away from direct sunlight.
1. Remove the new maintenance box from its package.

   **Caution:** Do not touch the green chip on the maintenance box.

2. Turn off the product and disconnect the power cord and USB cable.
3. Close the cover and turn the product upside-down.

4. Press the tabs with a sharp object as shown and remove the maintenance box cover.
5. Slide the maintenance box as shown and pull it out.

![Diagram of maintenance box being pulled out]

**Caution:** Do not touch the areas shown below. Doing so may prevent normal operation and cause ink to leak.

![Warning symbol with areas not to touch]

**Warning:** If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep the maintenance box out of the reach of children and do not drink the ink.

6. Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal the bag and dispose of it carefully.

7. Place the new maintenance box in the holder and slide it into place.

![Diagram of new maintenance box being placed in holder]

8. Reattach the maintenance box cover.
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path Using the Product Control Panel

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning

Parent topic: Adjusting Print Quality
Related topics
Replacing Ink Cartridges and Maintenance Boxes

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1. Load a few sheets of plain paper in the product.
2. From the Home screen, select Menu and press the OK button.
You see this screen:

3. Press the arrow buttons to select **Maintenance** and press the **OK** button.
4. Press the arrow buttons to select **Nozzle Check** and press the **OK** button.
   You see this screen:

5. Press the **OK** button.
   The nozzle check pattern is printed.
6. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean]

   **Print head needs cleaning**

   ![Print head needs cleaning]

7. Do one of the following:
   - If there are no gaps, the print head is clean. Select **No** and press the **OK** button.
   - If there are gaps or the pattern is faint, select **Yes** and press the **OK** button to continue. Follow the instructions on the screen to clean the print head.

If you don’t see any improvement after cleaning the print head up to 2 times, turn the product off and wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** Print Head Nozzle Check

**Related concepts**
- Print Head Cleaning

**Related tasks**
- Cleaning the Print Head Using the Product Control Panel

**Related topics**
- Replacing Ink Cartridges and Maintenance Boxes
Loading Paper

Checking the Nozzles Using a Computer Utility

You can check the print head nozzles using a utility on your Windows or Mac computer.

1. Load a few sheets of plain paper in the product.
2. Do one of the following:
   - **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
   - **Mac**: In the Apple menu or the Dock, select **System Preferences**, Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
3. Select **Nozzle Check**.
   You see a window like this:
4. Click **Print**.
5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean]

   **Print head needs cleaning**

   ![Print head needs cleaning]

6. If there are no gaps, click **Finish**.
   
   If there are gaps or the pattern is faint, clean the print head.

**Parent topic:** Print Head Nozzle Check

**Related concepts**

- Print Head Cleaning

**Related tasks**

- Cleaning the Print Head Using a Computer Utility

**Related topics**

- Replacing Ink Cartridges and Maintenance Boxes
- Loading Paper
Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head.

**Note:** You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility

**Parent topic:** Print Head Maintenance

**Related tasks**
Removing and Installing Ink Cartridges

Cleaning the Print Head Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1. Load a few sheets of plain paper in the product.
2. From the home screen, select **Menu** and press the **OK** button.
   
   ![Menu screen](image)

3. Press the arrow buttons to select **Maintenance** and press the **OK** button.
4. Press the arrow buttons to select **Head Cleaning** and press the **OK** button.
You see this screen:

![Image of LCD screen showing clean print head to correct missing dots.

5. Press the **OK** button to clean the print head. You see a message on the LCD screen during the cleaning cycle.

   **Caution:** Never turn off the product during a cleaning cycle or you may damage it.

When the cleaning cycle is finished, you see a message on the LCD screen.

6. Select **Nozzle check** and press the **OK** button.

7. Press the **OK** button again to run a nozzle check and confirm that the print head is clean.

If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** Print Head Cleaning

**Related tasks**

- Checking the Nozzles Using the Product Control Panel
- Removing and Installing Ink Cartridges

**Related topics**

- Loading Paper

**Cleaning the Print Head Using a Computer Utility**

You can clean the print head using a utility on your Windows or Mac computer.

1. Load a few sheets of plain paper in the product.
2. Do one of the following:
   • **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
   • **Mac**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

3. Select **Head Cleaning**.
   You see a window like this:

4. Click **Start** to begin the cleaning cycle.

   **Caution**: Never open the inner cover or turn off the product during a cleaning cycle or you may damage it.
5. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click **Print Nozzle Check Pattern** and click **Print**.

6. Check the printed pattern to see if there are gaps in the lines.

   - **Print head is clean**

   ![Print head is clean]

   - **Print head needs cleaning**

   ![Print head needs cleaning]

   - If there are no gaps, click **Finish**.
   - If there are gaps or the pattern is faint, click **Clean** to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait at least 6 hours. Then check the print head nozzles and try cleaning the print head again, if necessary. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** Print Head Cleaning

**Related references**

Where to Get Help

**Related tasks**

Checking the Nozzles Using a Computer Utility

Removing and Installing Ink Cartridges
Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or light horizontal bands, you may need to align the print head.

**Note:** Banding may also occur if your print head nozzles need cleaning.

**Aligning the Print Head Using the Product Control Panel**

**Parent topic:** Adjusting Print Quality

You can align the print head using the control panel on your product.

1. Load a few sheets of plain paper in the product.
2. From the home screen, select **Menu** and press the **OK** button.
   
   You see this screen:

   ![Menu Screen](image)

3. Press the arrow buttons to select **Maintenance** and press the **OK** button.
4. Press the arrow buttons to select **Head Alignment** and press the **OK** button.
5. Press the arrow buttons to select **Vertical Alignment** or **Horizontal Alignment** and press the **OK** button.

6. Press the **OK** button again to print an alignment sheet.

   **Note:** Do not cancel printing while you are printing a head alignment pattern.

7. Check the printed pattern and select the number representing the most solid printed pattern for each set on the LCD screen.

   **Vertical alignment**

```
#1
```

1  2  3  4
8. Press the OK button when you are finished.

Parent topic: Print Head Alignment

Related topics
Loading Paper

Cleaning the Paper Path Using the Product Control Panel

You can clean the paper path using the control panel on your product.

1. Load a few sheets of plain paper in the product.
2. From the home screen, select Menu and press the OK button.
   You see this screen:

3. Press the arrow buttons to select Maintenance and press the OK button.
4. Press the arrow buttons to select **Paper Guide Cleaning** and press the **OK** button.
5. Follow the on-screen instructions to clean the paper path.
6. Repeat as necessary until the paper comes out clean.

*Parent topic: Adjusting Print Quality*
Transporting and Cleaning Your Product

Follow the instructions in these sections to transport your product or clean it if necessary.

Carrying and Transporting Your Product

Cleaning Your Product

Carrying and Transporting Your Product

Follow these tips for traveling with your product:

• Charge the product before you leave.
• Make sure you take the USB cable for convenient charging on the road.
• Take extra ink cartridges and a spare maintenance box.

Caution: Observe the following precautions when carrying or transporting the product:

• When traveling by airplane, Epson recommends handling the product as a carry-on. Contact the airline to confirm that you can take the product in the passenger cabin.
• Avoid strong impacts, which may damage the product.
• Leave the ink cartridges and maintenance box installed; otherwise, the print head may dry out or ink may leak.
• Do not leave the product in direct sunlight, near heat sources, or inside cars or other hot locations. The product may be deformed or ink may leak.

1. Turn off the product, and make sure the power light and the LCD screen turn off.
2. Disconnect the AC adapter and USB cable.
3. Close the printer cover.
4. If you need to ship the product, place it in its original packing materials, if possible, or use equivalent materials with cushioning around the product.

Note: When storing or transporting the product, position it as shown here:
If print quality has declined when you print again, clean and align the print head.

**Parent topic:** Transporting and Cleaning Your Product

**Related concepts**

- Purchase Epson Ink Cartridges and Maintenance Box
- Print Head Cleaning
- Print Head Alignment
- Battery Charging

## Cleaning Your Product

To keep your product working at its best, you should clean it whenever necessary. Close the cover when you are not using the product to protect it from dust.

**Caution:** Do not use a hard brush, benzene, alcohol, or paint thinner to clean the product or you may damage it. Do not place anything on top of the product or use the cover as a writing surface, or it could get permanently scratched. Do not use oil or other lubricants inside the product or let water get inside.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Clean the outer case and control panel with a soft, dry cloth. Do not use any liquid or chemical cleansers.

**Parent topic:** Transporting and Cleaning Your Product
Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates
Product Status Messages
Running a Product Check
Resetting Control Panel Defaults
Solving Power and Battery Problems
Solving Setup Problems
Solving Network Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software. Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Note: Your printer is designed to work only with genuine Epson-brand ink cartridges. Other brands of ink cartridges and ink supplies are not compatible and, even if described as compatible, may not function properly or at all. Epson periodically provides firmware updates to address issues of security, performance, minor bug fixes and ensure the printer functions as designed. These updates may affect the functionality of third-party ink. Non-Epson branded or altered Epson cartridges that functioned prior to a firmware update may not continue to function.

- Windows: Your printer software automatically checks for updates. You can also manually update the software by selecting Software Update here:
  - Access the Windows Desktop and right-clicking the icon for your product in the right side of the Windows taskbar, or clicking the up arrow and right-clicking .
  - On the Maintenance tab in the printer settings window
You can also update the software by selecting **EPSON Software Updater** in the **EPSON** or **EPSON Software** program group, accessible by the **Start** button, or on the **Start** or **Apps** screens, depending on your version of Windows.

- **OS X**: You can manually update the software by opening the **Applications > Epson Software** folder and selecting **EPSON Software Updater**.

- **macOS 10.12.x, 10.13.x, or 10.14.x**: You can manually update the software by opening the **App Store**, selecting **Updates**, searching for a software update option for Epson Software, and selecting **Update**.

**Parent topic:** [Solving Problems](#)

### Product Status Messages

If you see an error code on the LCD screen, see the solutions here to troubleshoot it.

<table>
<thead>
<tr>
<th>LCD code</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-01</td>
<td>A printer error has occurred. Turn the product off and then back on again. If the error continues, check for a paper jam. If there is no paper jam, contact Epson for support.</td>
</tr>
<tr>
<td>E-11</td>
<td>The ink pad is at the end of its service life. Turn off the product and contact Epson for support.</td>
</tr>
<tr>
<td>E-12</td>
<td>The maintenance box is full. Turn off the product and replace the maintenance box.</td>
</tr>
<tr>
<td>E-13</td>
<td>The maintenance box is missing or not installed correctly. Turn off the product and install the maintenance box.</td>
</tr>
<tr>
<td>E-14</td>
<td>The maintenance box is not recognized. Turn off the product and install the maintenance box. If the error continues, replace the maintenance box.</td>
</tr>
<tr>
<td>E-21</td>
<td>A battery error has occurred, and the product has turned off automatically. Contact Epson for support.</td>
</tr>
<tr>
<td>E-22</td>
<td>The battery is too cold, and the product has turned off automatically. Use the product within a temperature range of 50 to 95 °F (10 to 35 °C).</td>
</tr>
<tr>
<td>E-23</td>
<td>The battery is too hot, and the product has turned off automatically. Use the product within a temperature range of 50 to 95 °F (10 to 35 °C).</td>
</tr>
<tr>
<td>E-24</td>
<td>The battery is too low, and the product has turned off automatically. Charge the battery or connect the AC adapter.</td>
</tr>
<tr>
<td>LCD code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>W-01</td>
<td>Paper is jammed in the rear paper feed. Remove the jammed paper, then press the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>W-02</td>
<td>Paper is jammed inside the product. Remove the jammed paper, then press the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>W-11</td>
<td>An ink pad is nearing the end of its service life. Contact Epson for support. (To continue printing, press the <strong>OK</strong> button.)</td>
</tr>
<tr>
<td>W-12</td>
<td>An ink cartridge is installed incorrectly. Press down each of the ink cartridges gently to make sure they are installed correctly.</td>
</tr>
<tr>
<td>W-13</td>
<td>An ink cartridge indicated on the LCD screen is not recognized. Replace the ink cartridge. Epson recommends using genuine Epson ink cartridges.</td>
</tr>
<tr>
<td>I-22</td>
<td>To establish a wireless connection using an access point, press the button on the access point or click the button on the access point's wireless settings screen displayed on your computer screen.</td>
</tr>
<tr>
<td>I-23</td>
<td>Enter the PIN code displayed on the LCD screen into the access point or computer within two minutes. If you wait longer than two minutes, a time-out error occurs, the code changes, and you must enter a new code.</td>
</tr>
<tr>
<td>I-31</td>
<td>To make wireless connection settings from your computer, insert your product CD into your computer and follow the on-screen instructions.</td>
</tr>
<tr>
<td>I-41</td>
<td>The Paper Configuration setting must be turned on to use AirPrint.</td>
</tr>
<tr>
<td>I-81</td>
<td>The product is switching to battery power because the AC adapter is disconnected. Printing may be slower when running on the battery.</td>
</tr>
<tr>
<td>—</td>
<td>Ink is low. Continue printing until you are prompted to replace the ink cartridge(s).</td>
</tr>
<tr>
<td>—</td>
<td>An ink cartridge is expended. Replace the ink cartridge.</td>
</tr>
<tr>
<td>—</td>
<td>A non-genuine battery is installed. Remove the external battery.</td>
</tr>
<tr>
<td>Recovery mode</td>
<td>An error has occurred during firmware updating. Connect your product using a USB cable and try updating the firmware again. If you still receive this error message, contact Epson for support.</td>
</tr>
</tbody>
</table>

**Note:** The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages. During the life of your product it may reach a condition where either satisfactory print quality cannot be maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your LCD screen, or lights on the control panel will advise you when these parts need replacing. If this...
happens during the standard warranty of the product, the exchange of the product or replacement of the pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

**Running a Product Check**

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. From the home screen, select **Menu** and press the **OK** button.
You see this screen:

4. Press the arrow buttons to select **Maintenance** and press the **OK** button.
5. Press the arrow buttons to select **Nozzle Check** and press the **OK** button.

You see this screen:

6. Press the **OK** button.
   
The nozzle check pattern is printed.

7. Do one of the following, depending on the results of the product check:
   - If the page prints and the nozzle check pattern is complete, the product is operating properly. Any operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer software.

- If the page prints but the nozzle check pattern has gaps, clean or align the print head.
- If the page does not print, the product may have a problem. Check the other solutions in this manual. If they do not work, contact Epson.

**Parent topic:** Solving Problems  
**Related concepts**  
Print Head Cleaning  
Print Head Alignment  
Uninstall Your Product Software  
**Related references**  
Where to Get Help  

### Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory defaults. You can choose which settings to reset or reset them all.

1. From the home screen, select Menu and press the OK button. You see this screen:
2. Press the arrow buttons to select **Restore Default Settings** and press the **OK** button.

![Image of Restore screen]

3. Select one of these options and press the **OK** button:
   - **Network Settings**: Resets all network settings.
   - **All Except Network**: Resets all control panel settings, except for network settings.
   - **All Settings**: Resets all control panel settings.

   You see a confirmation screen.

4. Select **Yes** and press the **OK** button to reset the selected settings. (Select **No** and press the **OK** button if you want to cancel the operation.)

**Parent topic:** Solving Problems

---

**Solving Power and Battery Problems**

Check these sections if you have power or battery problems.

- **Product Does Not Turn on**
- **Product Does Not Turn Off**
- **Product Turns Off Automatically**
- **Battery Does Not Charge From Computer**

**Parent topic:** Solving Problems
Product Does Not Turn on

If your product does not turn on, try these solutions:

• Hold down the I/O power button for a few seconds.
• Make sure the power cord is securely plugged in.
• Make sure the battery is charged.

Parent topic: Solving Power and Battery Problems

Related concepts
Battery Charging

Related references
Status Icons

Product Does Not Turn Off

If your product does not turn off, do the following:

1. Disconnect the AC adapter and the USB cable.
2. Hold down the I/O power button and the ☢ cancel button at the same time for more than 7 seconds, then release both buttons. The product turns off.
3. To prevent the print head from drying out, turn your product back on and turn it off again by pressing the I/O power button.

Parent topic: Solving Power and Battery Problems

Product Turns Off Automatically

If your product turns off automatically, try these solutions:

• The LCD screen turns off when the product goes into sleep mode. Press any button to turn the screen on.
• The product's Power Off Timer turns it off when it is not in use. Press the I/O power button to turn your product back on.
• If the product was running on the battery, you may have to connect the AC adapter to charge the battery. Press the I/O power button to turn the product back on.

Parent topic: Solving Power and Battery Problems

Related concepts
Battery Charging
Battery Does Not Charge From Computer

If you are unable to charge your product by connecting it to a computer, try these solutions:

• Check the battery setting on the product control panel.
  1. Disconnect the USB cable.
  2. On the product control panel, select Menu > Battery > Battery Settings > USB Power Supply via PC > On.
  3. Turn the product off and reconnect the USB cable for charging.

• Make sure the product is turned off or in sleep mode.
• Make sure the computer is turned on and not in sleep or hibernate mode.
• Connect the product directly to the computer and not to a USB hub.
• The computer may be configured not to allow other devices to charge when the computer is running on its battery. Check your computer's settings.
• Make sure to charge the optional battery using the AC adapter; you cannot charge it from a computer.

Parent topic: Solving Power and Battery Problems
Related concepts
Battery Charging

Solving Setup Problems

Check these sections if you have problems while setting up your product.

Noise After Ink Installation
Software Installation Problems

Parent topic: Solving Problems

Noise After Ink Installation

If you hear noises from your product after installing ink, check the following:

• The first time you install the ink cartridges, the product must charge its print head. Wait until charging finishes before you turn off the product, or it may charge improperly and use excess ink the next time you turn it on.
If the product’s print head stops moving or making noise, and the charging process has not finished after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems
Related references
Where to Get Help

Software Installation Problems
If you have problems while installing your product software, try these solutions:

• Make sure your product is turned on and any necessary cables are securely connected at both ends. If you still have problems installing software, disconnect the cable and carefully follow the instructions in the Quick Guide. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have software installation privileges. Contact your system administrator.

Parent topic: Solving Setup Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Cannot Connect to a Wireless Router or Access Point

If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

- Make sure to place your product within contact range of your router or access point. Avoid placing your product near a microwave oven, cordless phone, or large metal object, such as a filing cabinet.

- Verify that your router or access point is operating correctly by connecting to it from your computer or another device.

- Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.

- You may need to disable the firewall and any anti-virus software on your wireless router or access point.

- Try restarting your router following the instructions in your router documentation.

**Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router.

- Check to see if access restrictions, such as MAC address filtering, are set on the router or access point. If access restrictions are set, add your product's MAC address to your router's address list. To obtain your product's MAC address, print a network status sheet. Then follow the instructions in your router or access point documentation to add the address to the list.

- If your router or access point does not broadcast its network name (SSID), follow the instructions that came with your product to enter your wireless network name manually.

- If your router or access point has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.
• Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.

• If you cannot connect your product to a device using Wi-Fi Direct, you may have exceeded the maximum number of devices connected to your product (8). Print a network status sheet or access Web Config on the browser for your device and check the number of connected devices. If 8 devices are already connected, disconnect a device by deleting the product's SSID from the Wi-Fi screen of that device. If fewer than 8 devices are connected, check the accuracy of your other network settings, move your device closer to your product, and try connecting again.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection settings from your device and enter a new password. See your device documentation for instructions.

**Parent topic:** Solving Network Problems

**Related concepts**

Wi-Fi Direct Mode Setup

**Related tasks**

Printing a Network Status Sheet

Printing a Network Connection Report

Selecting Wireless Network Settings from the Control Panel

Disabling Wi-Fi Features

**Related topics**

Wi-Fi Networking

---

**Network Software Cannot Find Product on a Network**

If EpsonNet Setup cannot find your product on a network, try these solutions:

• Make sure your product is turned on and connected to your network. Verify the connection using your product control panel.

• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-ASCII characters.

• Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.

• Make sure your product is not connected to a guest network.

• If necessary, reinstall your product software and try running EpsonNet Setup again:
  1. Reset your product's network settings to their factory defaults.
2. **Windows only**: Uninstall your product software.

3. Restart your router following the instructions in your router documentation.

   **Note**: If you are reading these instructions online, you will lose your Internet connection when you restart your router, so note the next step before restarting it.

4. Download your product software from the Epson website using the instructions in the *Quick Guide*.
   - If you have replaced your router, reinstall your product software to connect to the new router.
   - Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing detection of your device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

**Parent topic**: Solving Network Problems

**Related concepts**

Uninstall Your Product Software

**Related topics**

Wi-Fi Networking

**Product Does Not Appear in Mac Printer Window**

If your product does not appear in the Mac printer window, try these solutions:

- Turn your product off, wait 30 seconds, then turn it back on again.
- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.
- If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi icon does not appear on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

**Parent topic**: Solving Network Problems

**Related tasks**

Uninstalling Product Software - Mac

**Wireless Network Connection is Unstable on a Mac**

If you connected a device to a USB 3.0 port on your Mac, you may experience wireless network interference between your product and your Mac.
If you cannot connect to your product over the wireless network or the connection becomes unstable, move the device connected to your Mac USB 3.0 port further away from your Mac.

Parent topic: Solving Network Problems

Cannot Print Over a Network

If you cannot print over a network, try these solutions:

- Make sure that your product is turned on.
- Make sure you install your product’s network software as described in your product documentation.
- Print a network status sheet and verify that the network settings are correct. If the network status is **Disconnected**, check any cable connections and turn your product off and then on again.
- Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.
- If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your network does not assign IP addresses using DHCP, set the IP address manually.
- Make sure your computer and product are both using the same wireless network.
- If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place your product closer to your router or access point. Avoid placing your product near a microwave oven, cordless phone, or large metal object, such as a filing cabinet.
- Try restarting your router following the instructions in your router documentation.

**Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router.

- Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing printing from a device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.
- If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi connection icon is not lit or does not appear on the product's LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems

Related tasks

- Printing a Network Status Sheet
- Uninstalling Product Software - Mac
Solving Paper Problems

Check these sections if you have problems using paper with your product.

Paper Feeding Problems
Paper Jam Problems in the Rear Paper Feed
Paper Jam Problems Inside the Product

Parent topic: Solving Problems

Paper Feeding Problems

If you have problems feeding paper, try these solutions:

• Place the product on a flat surface.
• If the battery is running low, connect the AC adapter.
• If paper does not feed for printing, remove it. Then reload it in the rear paper feed against the right side and beneath the tab. Slide the edge guide against the edge of the paper.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• Do not load more than the recommended number of sheets.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure your paper meets the specifications for your product.
• Make sure the paper size and paper type settings on the control panel are correct.
• Try cleaning the paper path.
• For best results, follow these guidelines:
  • Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
  • Load paper in the rear paper feed printable side up.
  • Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Rear Paper Feed
Paper Jam Problems Inside the Product
Paper Jam Problems in the Rear Paper Feed
If paper has jammed in the rear paper feed, remove it as shown here.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems Inside the Product

Paper Jam Problems Inside the Product
If paper has jammed inside the product, remove it as described here.
1. Open the inner cover.
2. Remove the jammed paper.

Caution: Do not touch the flat white cable or translucent part inside the product.

3. Close the inner cover.

Parent topic: Solving Paper Problems

Related references

- Paper Jam Problems in the Rear Paper Feed

Solving Problems Printing from a Computer

Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this manual. See the Apple website for details.

- Nothing Prints
- Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement
Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:

• Make sure your product is turned on and connected to your computer.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your product directly to your computer instead of the hub.
• Make sure the printer status is not offline or pending.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product software is installed correctly.
• Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. Print the image at a lower resolution or if necessary, increase your system's memory.
• In Windows, make sure your product is selected as the default printer and the printer port setting matches the printer connection port.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.
• On a Mac, make sure the printer is added to the printer list and the printer is not paused.
Parent topic: Solving Problems Printing from a Computer
Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does not work, try this solution:

1. Do one of the following:

   • Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printing preferences.
• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

• Windows 7: Click and select Devices and Printers. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

• Windows Vista: Click, select Control Panel, and click Printer under Hardware and Sound. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

2. Click the Maintenance tab.
3. Click the Extended Settings button.
4. Select Enable EPSON Status Monitor 3 and click OK.
5. Click the Monitoring Preferences button.
6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.

Parent topic: Solving Problems Printing from a Computer

Error After Cartridge Replacement

If you see an error light or error message after you replace an ink cartridge, follow these steps:

1. Make sure the print head is in the ink cartridge replacement position. (The ink cartridge holder should be beneath the cutout in the product case.)

   Note: If the print head is not in the ink cartridge replacement position, follow the instructions on replacing an ink cartridge in this manual to move it.

2. Remove and reinsert the replaced ink cartridge, making sure to push it all the way into its slot.
3. Complete the ink cartridge installation steps.

Parent topic: Solving Problems Printing from a Computer

Related tasks
Removing and Installing Ink Cartridges
Printing is Slow

If printing becomes slow, try these solutions:

• Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system’s memory.

• If you are using Windows 7, close the Devices and Printers window before you print.

• On a Mac, make sure you download and install the Epson printer driver.

• Make sure Quiet Mode is turned off.

• Clear space on your hard drive or run a defragmentation utility to free up existing space.

• Close any programs you are not using when you print.

• If your product is connected to a USB hub, connect it directly to your computer instead.

• Connect the AC adapter instead of running on the battery.

• If printing becomes slower after printing continuously for a long time, the product may have automatically slowed down to protect the print mechanism from overheating or becoming damaged. Let the product rest with the power on for 30 minutes, then try printing again.

• If you are printing over a wireless network, factors such as interference, network traffic, or weak signal strength may affect your printing speed.

For the fastest printing, select the following settings in your product software:

• Make sure the paper type setting matches the type of paper you loaded.

• Turn on any high speed settings in your product software.

• Select a lower print quality setting.

• On the product control panel, make sure Plain Paper Density Setting is set to Standard.

• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress, and select the following settings:

  • Always Spool RAW Datatype
  • Page Rendering Mode
  • Print as Bitmap

• Windows: Select Printer Properties, click the More Options tab, and make sure the High Speed setting is enabled.
• **Mac**: Select **System Preferences**, select **Printers & Scanners**, and select your product. Select **Options & Supplies**, select **Options** (or **Driver**), and enable the **High Speed Printing** setting.

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select **Computer** or **My Computer**. Double-click the C: drive and open these folders: **ProgramData > EPSON > PRINTER**.

   **Note**: If you do not see the ProgramData folder, open the **Organize** menu and select **Folder and search options**. In the window that appears, click the **View** tab, select **Show hidden files, folders, and drives** in the Advanced settings list, and click **OK**.

2. Right-click the **EPAUDF01.AUD** file and select **Delete**.
3. Restart your computer and try printing again.

**Parent topic**: Solving Problems Printing from a Computer

**Related references**
- Windows System Requirements
- Mac System Requirements
- Paper or Media Type Settings - Printing Software

**Related tasks**
- Turning On Quiet Mode
- Adjusting Print Density
- Selecting Basic Print Settings - Windows
- Selecting Extended Settings - Windows
- Selecting Basic Print Settings - Mac
- Selecting Printing Preferences - Mac

---

**Solving Page Layout and Content Problems**

Check these sections if you have problems with the layout or content of your printed pages.

**Note**: When printing using AirPrint, the available print settings are different from those covered in this manual. See the Apple website for details.

- Inverted Image
- Too Many Copies Print
- Blank Pages Print
Inverted Image

If your printed image is inverted unexpectedly, try these solutions:

- Turn off any mirror or inversion settings in your printing application.
- Turn off the **Mirror Image**, **Flip horizontally**, or **Reverse page orientation** settings in your printer software. (This option has different names, depending on your operating system version.)

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**
- Selecting Basic Print Settings - Mac
- Selecting Additional Layout and Print Options - Windows

Too Many Copies Print

Make sure that the **Copies** setting in your printing program or printer software is not set for multiple copies.

**Parent topic:** Solving Page Layout and Content Problems

Blank Pages Print

If blank pages print unexpectedly, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- If a blank page exists in a document you are printing and you want to skip printing it, select the **Skip Blank Page** setting in your printer software, if available.
- Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
- Make sure your product is selected as the printer in your printing program.

**Parent topic:** Solving Page Layout and Content Problems
Incorrect Margins on Printout

If your printed page has incorrect margins, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- Make sure you selected the correct margins for your paper size in your printing program.
- Make sure your paper is positioned correctly for feeding into the product.
- Make sure the guide on the right side of the rear paper feed slot is all the way on the right, then reload paper.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Border Appears on Borderless Prints

If you see a border on borderless prints, try these solutions:

- Make sure you are printing on a compatible borderless paper type and size.

Note: For custom paper sizes, make sure you select a supported borderless page width.
• **Windows**: Make sure you selected the **Borderless** setting in your printer software.

• **Mac**: Make sure you selected the **Borderless** checkbox or a paper size with a **Borderless** option in your printer software.

• Adjust the **Expansion** setting to adjust the amount of image expansion on the edges of borderless prints.

• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement may not be enough to cover the paper.

**Parent topic:** Solving Page Layout and Content Problems

**Related references**

Borderless Paper Type Compatibility

**Related tasks**

- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac
- Selecting Page Setup Settings - Mac

---

**Incorrect Characters Print**

If incorrect characters appear in your prints, try these solutions before reprinting:

• Make sure any cables are securely connected at both ends.

• In Windows, delete all jobs from the Windows Spooler. Click **Print Queue** on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.

• If your product is connected to a USB hub, connect it directly to your computer instead.

• If your computer entered sleep mode the last time you printed, the next print job after your computer exits sleep mode may contain garbled characters. Print your document again.

**Parent topic:** Solving Page Layout and Content Problems

---

**Incorrect Image Size or Position**

If your printed image is the wrong size or in the wrong position, try these solutions:

• Make sure you selected the correct paper size and layout settings in your printing program and printer software.

• Make sure you selected the correct paper size on the control panel.

• Make sure your paper is positioned correctly for feeding into the printer.

• Slide the edge guides against the edges of the paper.
• Make sure the part on the right side of the rear paper feed slot is all the way on the right, then reload paper.
• Make sure you selected the correct margins for your paper size in your printing program.
• If the image is slightly enlarged and cropped during borderless printing, change the Expansion setting.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
Selecting Print Settings - Windows Basic Driver

Related topics
Loading Paper

Slanted Printout

If your printouts are slanted, try these solutions:
• Make sure your paper meets the specifications for your product.
• Do not load more than the recommended number of sheets.
• Slide the edge guide against the edge of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.

Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Alignment

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout

If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Make sure the paper type setting matches the type of paper you loaded.
- Make sure you loaded the printable side of the paper correctly for your product.
- Turn off any high speed settings in your product software.
- Align the print head. If print quality does not improve after aligning the print head, disable the bidirectional (high speed) setting.
- Adjust the print quality in the product software.
- You may need to replace the ink cartridges.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Alignment
Print Head Nozzle Check
Print Head Cleaning

Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac
Selecting Print Settings - Windows Basic Driver

Related topics
Loading Paper
Replacing Ink Cartridges and Maintenance Boxes

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Dry printouts completely before filing or displaying them. When drying printouts, avoid direct sunlight, do not use a dryer, and do not touch the printed side of the paper.
• Do not stack printouts immediately after printing.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first. Adjust the density and/or ink drying time settings.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.
• Use the ink before the date printed on the package.
Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Paper Specifications

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac
Selecting Print Settings - Windows Basic Driver
Cleaning Your Product

Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• On the product control panel, select Menu > Plain Paper Density Setting and increase the density.
• On the product control panel, select Menu > Color Adjustment and adjust the color.
• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.
Grainy Printout

If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Align the print head.
• Adjust the print quality in the product software.
• You may need to increase the image resolution or print a smaller size; see your software documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

• If you enlarged the image size in an image-editing program, you need to increase the image resolution setting to retain a high image quality. Increase the image resolution by the same amount you increase the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the image size for printing, change the resolution setting to 600 dpi.
Note: Higher resolution settings result in larger file sizes, which take longer to process and print. Consider the limitations of your computer system when selecting a resolution, and select the lowest possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac
Selecting Print Settings - Windows Basic Driver

Related topics
Loading Paper

Incorrect Colors

If your printouts have incorrect colors, try these solutions:

• Make sure the paper type setting matches the paper you loaded.
• Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors may look different than you expect. To speed up drying time, do not stack your printouts on top of each other.
• Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Try using the color management options in your printer software.
• Try turning off the PhotoEnhance setting in Windows.
• For best results, use genuine Epson paper.
• On the product control panel, select **Menu > Color Adjustment** and adjust the color.

**Parent topic:** Solving Print Quality Problems

**Related concepts**
Print Head Nozzle Check  
Print Head Cleaning

**Related references**
Compatible Epson Papers

**Related tasks**
Selecting Basic Print Settings - Windows  
Selecting Additional Layout and Print Options - Windows  
Selecting Basic Print Settings - Mac  
Selecting Print Settings - Windows Basic Driver  
Adjusting Color  
Managing Color - Mac

**Related topics**
Replacing Ink Cartridges and Maintenance Boxes

---

**Uninstall Your Product Software**

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

**Uninstalling Printing Software - Windows**

You can uninstall and then re-install your printer software to solve certain problems.

1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

   • **Windows 10**: Click and select **(Settings) > Apps > Apps & features**. Select the program you want to uninstall and select **Uninstall**.
• **Windows 8.x**: Navigate to the **Apps** screen and select **Control Panel > Programs > Programs and Features**. Select the uninstall option for your Epson product, then select **Uninstall/Change**.

  **Note:** If you see a **User Account Control** window, click **Yes** or **Continue**.

  In the next window, select your product, if necessary, and click **OK**. Then follow any on-screen instructions.

• **Windows (other versions)**: Click or **Start**, and select **All Programs** or **Programs**. Select **Epson**, select your product, then click **EPSON Printer Software Uninstall**.

  **Note:** If you see a **User Account Control** window, click **Yes** or **Continue**.

  In the next window, select your product, if necessary, and click **OK**. Then follow any on-screen instructions.

4. Restart your computer, then re-install your software.

  **Note:** If you find that re-installing your product software does not solve a problem, contact Epson.

**Parent topic:** [Uninstall Your Product Software](#)

### Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

**Note:** If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

2. Click **Downloads**.

3. Select your operating system, click **Utilities**, locate the Uninstaller utility, and click **Download**.

4. Run the file you downloaded.

5. Double-click the **Uninstaller** icon.

6. In the Epson Uninstaller screen, select the checkbox for each software program you want to uninstall.
7. Click **Uninstall**.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

**Note:** If you uninstall the printer driver and your product name remains in the **Print & Fax**, **Print & Scan**, or **Printers & Scanners** window, select your product name and click the – (remove) icon to remove it.

**Parent topic:** Uninstall Your Product Software

## Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

### Internet Support

Visit Epson’s support website at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

### Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

- **Product name**
- **Product serial number (located on a label on the product)**
- **Proof of purchase (such as a store receipt) and date of purchase**
- **Computer configuration**
- **Description of the problem**

Then call:

- **U.S.:** (562) 276-7202, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday
- **Canada:** (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.
Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Parent topic: Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating systems:
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2
• Windows Server 2012
• Windows Server 2008 R2
• Windows Server 2008
• Windows Server 2003 R2
• Windows Server 2003 SP2 or later

**Note:** For the latest product software available for your operating system, visit the Epson support site at [epson.com/support](http://epson.com/support) (U.S.), [epson.ca/support](http://epson.ca/support) (Canada), or [epson.com.jm/support](http://epson.com.jm/support) (Caribbean), select your product, and select **Downloads**.

**Parent topic:** Technical Specifications

## Mac System Requirements

To use your product and its software, your Mac should use one of these operating systems:

• macOS 10.14.x
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8

**Note:** For the latest product software available for your operating system, visit the Epson support site at [epson.com/support](http://epson.com/support) (U.S.), [epson.ca/support](http://epson.ca/support) (Canada), or [epson.com.jm/support](http://epson.com.jm/support) (Caribbean), select your product, and select **Downloads**.

**Parent topic:** Technical Specifications

## Paper Specifications

**Note:** Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.
### Single-sheets

**Size**
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- A6 (4.1 × 5.8 inches [105 × 148 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- Legal (8.5 × 14 inches [216 × 356 mm])
- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- 8 × 10 inches (203 × 254 mm)
- 3.5 × 5 inches (89 × 127 mm)
- 16:9 wide (4 × 7.1 inches [102 × 181 mm])
- Half Letter (5.5 × 8.5 inches [140 × 216 mm])

**Paper types**
- Plain paper

**Note:** Your product also supports compatible papers distributed by Epson. See the link at the end of this topic for a list of compatible Epson papers.

**Weight**
- Plain paper: 17 lb (64 g/m²) to 24 lb (90 g/m²)

### Envelopes

**Size**
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

**Paper types**
- Plain paper

**Weight**
- 20 lb (75 g/m²) to 24 lb (90 g/m²)

---

**Parent topic:** Technical Specifications

---

### Printable Area Specifications

**Note:** When printing borderless, quality may decline in the expanded printable area.
Single sheets - borders

1. Top/bottom/left/right margins: 0.12 inch (3 mm) minimum; Letter- and Legal-size: 0.24 inch (6 mm)
2. Reduced print quality area/top: 1.62 inches (41 mm) minimum
3. Reduced print quality area/bottom: 1.46 inches (37 mm) minimum

Single sheets - borderless

1. Reduced print quality area/top: 1.73 inches (44 mm) minimum
2. Reduced print quality area/bottom: 1.57 inches (40 mm) minimum
Ink Cartridge Specifications

Note: Your printer is designed to work only with genuine Epson-brand ink cartridges. Other brands of ink cartridges and ink supplies are not compatible and, even if described as compatible, may not function properly or at all. Epson periodically provides firmware updates to address issues of security, performance, minor bug fixes and ensure the printer functions as designed. These updates may affect the functionality of third-party ink. Non-Epson branded or altered Epson cartridges that functioned prior to a firmware update may not continue to function.

The included initial cartridges are designed for reliable printer setup and cannot be used as replacement cartridges or resold. After setup, the remaining ink is available for printing. Yields are based on ISO 24711 in default mode, printing continuously. Yields vary due to print images, settings, and temperatures. Printing infrequently or primarily with one color reduces yields. All cartridges must be installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced cartridges.

**Color**

Black, Tri-Color
Cartridge life

Opened package: 6 months
Unopened package: do not use if the date on the package has expired

Temperature

Storage: –22 to 104 °F (–30 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (–16 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications
Related references
Ink Cartridge and Maintenance Box Part Numbers

Dimension Specifications

Height
Stored: 2.4 inches (61 mm)
Printing: 8.5 inches (217 mm)

Width
Stored: 12.2 inches (309 mm)
Printing: 12.2 inches (309 mm)

Depth
Stored: 6.3 inches (159 mm)
Printing: 9.1 inches (232 mm)

Weight
3.7 lb (1.7 kg)
(without ink cartridges and AC adapter)

Parent topic: Technical Specifications
# Electrical Specifications

## AC Adapter

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC adapter model</td>
<td>A462H</td>
</tr>
<tr>
<td>Rated input power supply voltage</td>
<td>AC 100–240 V</td>
</tr>
<tr>
<td>Rated input current</td>
<td>1 A</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td>50–60 Hz</td>
</tr>
<tr>
<td>Rated output power supply voltage</td>
<td>DC 24 V</td>
</tr>
<tr>
<td>Rated Output current</td>
<td>1 A</td>
</tr>
</tbody>
</table>

## Printer Using the AC Adapter

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated DC input power supply voltage</td>
<td>DC 24 V</td>
</tr>
<tr>
<td>Rated DC input</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not charging battery: 0.4 A</td>
</tr>
<tr>
<td></td>
<td>Charging built-in battery: 0.6 A</td>
</tr>
<tr>
<td></td>
<td>Charging optional external battery: 0.9 A</td>
</tr>
</tbody>
</table>

### Power consumption (USB connection)

- **Not charging battery:**
  - Printing: Approximately 12 W (ISO/IEC24712)
  - Ready mode: Approximately 3.3 W
  - Sleep mode: Approximately 0.9 W
  - Power off mode: Approximately 0.2 W
- **Charging built-in battery:**
  - Printing: Approximately 16 W (ISO/IEC24712)
  - Ready mode: Approximately 14.6 W
  - Sleep mode: Approximately 12.1 W
  - Power off mode: Approximately 11.6 W
Charging optional external battery:

- Printing: Approximately 12 W (ISO/IEC24712); printer does not charge the battery while printing
- Ready mode: Approximately 23.6 W
- Sleep mode: Approximately 21.4 W
- Power off mode: Approximately 22 W

Built-in battery

- **Type**: Li-ion
- **Rated power supply voltage**: 3.6 V
- **Capacity of current**: 1.86 Ah
- **Continuous number of prints**
  - Color: Approximately 50 sheets
  - Monochrome: Approximately 100 sheets
  (Measured when printing A4-size ISO/IEC24712 patterns with a fully-charged new battery at 77 °F [25 °C].)
- **Charging time**
  - AC adapter: Approximately 2.5 hours*
  - USB port (5 V/0.5 A): Approximately 10 hours
  - USB port (5 V/1.5 A): Approximately 2.5 hours
  (Measured when charging the battery with power off at 77 °F [25 °C]; longer if printing while charging.)

* 5 minutes of charging lets you print approximately 4 sheets of A4-size ISO/IEC24712 patterns in monochrome, or approximately 2 sheets of A4-size ISO/IEC24712 patterns in color.

**Parent topic:** Technical Specifications
**Environmental Specifications**

**Temperature**
- Operating: 50 to 95 °F (10 to 35 °C)
- Operational guaranteed temperature:
  - Using AC adapter: 32 to 104 °F (0 to 40 °C)
  - Running on built-in battery: 41 to 104 °F (5 to 40 °C)
  - Running on optional battery: 41 to 104 °F (5 to 40 °C)
- Storage: -22 to 140 °F (-30 to 60 °C)
  - 1 week at 140 °F (60 °C)

**Humidity**
- Operating: 20 to 80% RH
- (without condensation) Storage: 5 to 85% RH

**Parent topic:** Technical Specifications

**Interface Specifications**

**Interface type**
- Hi-Speed USB (Device Class for computers)

**Parent topic:** Technical Specifications

**Network Interface Specifications**

**Standards**
- IEEE802.11a/b/g/n/ac; IEEE80211.n available only for the HT20

**Frequency ranges**
- IEEE802.11b/g/n: 2.4 GHz
- IEEE802.11a/n/ac: 5 GHz (U.S. and Canada)
Wi-Fi channels

2.4 GHz:
1/2/3/4/5/6/7/8/9/10/11/12/13
5 GHz (U.S. and Canada)*:
W52 (36/40/44/48)
W53 (52/56/60/64)
W56 (100/104/108/112/116/120/124/128/132/136/140)
W58 (149/153/157/161/165)

Wi-Fi Direct channels

2.4 GHZ:
1/2/3/4/5/6/7/8/9/10/11/12/13
5 GHz (U.S. and Canada)*:
W52 (36/40/44/48)

Connection modes

Infrastructure mode
Wi-Fi Direct (Simple AP); not supported for IEEE802.11b

Note: Infrastructure and Wi-Fi Direct modes can be used simultaneously.

Wireless security protocols

WEP (64/128 bit)
WPA2-PSK (AES); complies with WPA2 standards with support for WPA/WPA2 Personal

Note: Wi-Fi Direct supports only WPA2-PSK (AES).

* The availability of outdoor use over these channels varies by location, as described in the table below.

Limitations for Using 5GHz Frequencies Outdoors (U.S. and Canada)
### Frequency range

<table>
<thead>
<tr>
<th>Frequency range</th>
<th>W52</th>
<th>W53</th>
<th>W56</th>
<th>W58</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>5150-5250 MHz</td>
<td>5250-5350 MHz</td>
<td>5470-5725 MHz</td>
<td>5725-5850 MHz</td>
</tr>
<tr>
<td>U.S.</td>
<td>Outdoor use allowed</td>
<td>Outdoor use allowed</td>
<td>Outdoor use allowed (except for channels 120/124/128)</td>
<td>Outdoor use allowed</td>
</tr>
<tr>
<td>Canada</td>
<td>Outdoor use prohibited</td>
<td>Outdoor use allowed</td>
<td>Outdoor use allowed (except for channels 120/124/128)</td>
<td>Outdoor use allowed</td>
</tr>
</tbody>
</table>

### Security

**Security protocol**  
SSL/TLS: HTTPS Server/Client, IPPS

**Parent topic:** Technical Specifications

### Safety and Approvals Specifications

**Product**

- **United States**: EMC: FCC part 15 Subpart B class B
- **Canada**: EMC: CAN ICES-3 (B)/NMB-3 (B)

This equipment contains the following wireless module:
- **Manufacturer**: Seiko Epson Corporation.
- **Type**: J26H005

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

**AC adapter**

**United States**  
Safety: UL60950-1  
EMC: FCC part 15 Subpart B class B

**Canada**  
Safety: CAN/CSA C22.2 No. 60950-1  
EMC: CAN ICES-3 (B)/NMB-3 (B)

**Parent topic:** Technical Specifications
Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions
Important Privacy Notice (Printer Serial Number)
FCC Compliance Statement
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions

Before using your Epson product, read and follow these safety instructions.

General Printer Safety Instructions
Ink Cartridge Safety Instructions
LCD Screen Safety Instructions
Wireless Connection Safety Instructions

Parent topic: Notices

General Printer Safety Instructions

• Be sure to follow all warnings and instructions marked on the printer.
• Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
• Use only the AC adapter that comes with the printer and do not use it with other equipment. Use of other cords with this product or use of the AC adapter with other products may cause fires or shock.
• Use only the type of power source indicated on the AC adapter's label.
• Make sure the AC power cord meets the relevant local safety standard.
• Place the printer near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed.
• If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.
• Always turn off the printer using the power button, and wait until the power light stops flashing before unplugging the printer or cutting off power to the electrical outlet.
• Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
• Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your product’s radio waves from affecting the operation of the pacemaker.
• Leave enough space in front of the printer for the paper to be fully ejected.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place the printer near a radiator or heating vent or in direct sunlight.
• Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.
• Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.
• Do not place or store the printer and the AC adapter outdoors, near excessive dirt or dust, water, heat sources, or in locations subject to shocks, vibrations, high temperature or humidity.
• When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.
• Do not put your hand inside the printer while it is printing.
• Do not touch the flat white cable inside the printer.
• Do not move the print head by hand; this may damage the printer.
• Do not spill liquid on the printer or AC adapter and do not handle the printer or AC adapter with wet hands.
• Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
• Except as specifically explained in your documentation, do not attempt to service the printer yourself.
• Unplug the printer and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in the plug, make sure you replace them with fuses of the correct size and rating.

• Unplug the power cord from the electrical outlet if you are not going to use the printer for an extended period.

• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the printer from printing.

• Before transporting the printer, make sure that the print head is in the home (far right) position and the ink cartridges are in place.

• When storing or transporting the printer, stand it on its side with the front of the printer facing up.

• The printer includes a built-in battery. When disposing of the printer, make sure to follow local battery disposal regulations.

**Parent topic:** Important Safety Instructions

### Ink Cartridge Safety Instructions

• Keep ink cartridges out of the reach of children and do not drink the ink.

• Keep the maintenance box out of the reach of children.

• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off thoroughly with soap and water. If it gets in your eyes, flush them immediately with water. If discomfort or vision problems persist, see a doctor immediately. If ink gets in your mouth, see a doctor immediately.

• Do not put your hand inside the product or touch any cartridges during printing.

• Do not allow dust or foreign objects to get inside the ink cartridge holder or you may not be able to print. Carefully remove any dust or foreign objects from the holder before installing ink cartridges and printing.

• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the product from printing.

• Install all ink cartridges; otherwise you cannot print.

• Do not open an ink cartridge until you are ready to install it in the printer. This may prevent normal operation.
• Make sure to remove the yellow tape from the cartridge before installing it; otherwise, print quality may decline or you may not be able to print. Do not remove or tear the label on the cartridge; this can cause leakage.

• Insert the ink cartridge in the correct direction; otherwise you may damage the product.

• The included initial cartridges are designed for reliable printer setup and cannot be used as replacement cartridges or resold. After setup, the remaining ink is available for printing.

• Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.

• Do not shake, squeeze, or drop cartridges after opening their packages and do not tear the cartridge labels; this can cause them to leak.

• Do not replace ink cartridges with the power off and do not move the print head by hand; otherwise, you may damage the printer.

• Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.

• If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.

• Use an ink cartridge before the date printed on its package.

• Do not dismantle an ink cartridge. This could damage the print head.

• Do not disassemble the ink cartridges or maintenance box; you may get ink in your eyes or on your skin.

• Store ink cartridges in a cool, dark place. Keep ink cartridges out of direct sunlight, and do not store in high or freezing temperatures.

• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

• Store ink cartridges with their labels facing up. Do not store cartridges upside down.

Parent topic: Important Safety Instructions

**LCD Screen Safety Instructions**

• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

• Do not press too hard on the LCD screen or subject it to heavy impacts.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson for support.
• The LCD screen may contain a few small bright or dark spots, and may display uneven brightness. These are normal and do not indicate that the screen is damaged in any way.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near such devices or inside a medical facility, follow the directions from authorized staff members at the facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

Important Privacy Notice (Printer Serial Number)

As part of setup, your product's serial number will be sent to a secure Epson server so that you can be eligible to participate in programs we may offer from time to time, including the Epson ink replenishment program. You will have a separate opportunity to consent to participating in such programs.

If you have any questions concerning this process, you can contact us by using the Privacy Feedback Form, or you can write to:

Epson America, Inc.
Attn: Privacy Coordinator
3840 Kilroy Airport Way
Long Beach, CA 90806-2469

Parent topic: Notices

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**WARNING**

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification or Declaration of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

**For Canadian Users**

CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices

## Binding Arbitration and Class Waiver

1. **Disputes, Binding Individual Arbitration, and Waiver of Class Actions and Class arbitrations**

   1.1 **Disputes.** The terms of this Section 1 shall apply to all Disputes between you and Epson. The term "Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim, controversy or action between you and Epson arising out of or relating to this Agreement, Epson branded products (hardware and including any related software), or other transaction involving you and Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation, ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement, (c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of action is for an IP Claim.

   1.2 **Binding Arbitration.** You and Epson agree that all Disputes shall be resolved by binding arbitration according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C. §1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to resolve the Dispute within the sixty (60) days, you or Epson may commence an arbitration. Notice to Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way, Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent address Epson has in its records for you. For this reason, it is important to notify us if your address changes by emailing us at EAIllegal@ea.epson.com or writing us at the Epson Address above. Notice of the Dispute shall include the sender’s name, address and contact information, the facts giving rise to the Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small claims court of your state or municipality if the action is within that court’s jurisdiction and is pending only in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED. ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY’S CLAIMS WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling 1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the interpretation, applicability, enforceability or formation of this Agreement.
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).
e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section 1.6d) above does not limit your rights to attorney's fees and expenses under applicable law; notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual arbitration procedure and waiver of class and representative proceedings specified in this Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent to this Agreement (including without limitation the purchase, download, installation of the Software or other applicable use of Epson Hardware, products and services) that specifies (i) your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding individual arbitration procedure and waiver of class and representative proceedings specified in this Section 1. In the event that you opt-out consistent with the procedure set forth above, all other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not apply to the prohibition against class or representative actions as provided in Section 1.5. This means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1) shall be null and void.

Parent topic: Notices

Trademarks

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson Connect™ is a trademark of Seiko Epson Corporation.

Epson Store℠ is a service mark of Epson America, Inc.

Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, App Store, AirPrint, AirPrint logo, iPad, iPhone, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.
Use of the Works with Apple badge means that an accessory has been designed to work specifically with the technology identified in the badge and has been certified by the developer to meet Apple performance standards.

Google® is a registered trademark and Android™ and Google Drive™ are trademarks of Google LLC.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product, or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution
A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to sleep to a shorter interval.

Copyright Attribution

© 2019 Epson America, Inc.
11/19
CPD-58007